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Pengenalan Komputer

Apa Itu Komputer ?

Komputer adalah sekumpulan alat elektronik yang saling bekerja sama
untuk menerima data, mengolah data, dan menampilkan data untuk
pengguna.

Perkembangan komputer dari pertama memasuki pasar hingga
sekarang dapat dibagi menjadi lima generasi yang berbeda.

Pengertian komputer yang didefinisikan secara berbeda
oleh beberapa ahli.

Menurut Blissmer (1985), komputer adalah suatu alat elektronik yang
mampu melakukan beberapa tugas, yaitu menerima input, memproses
input sesuai dengan instruksi yang diberikan, menyimpan perintah-
perintah dan hasil pengolahannya, serta menyediakan output dalam
bentuk informasi.

Sedangkan menurut Sanders (1985), komputer adalah sistem
elektronik untuk memanipulasi data yang cepat dan tepat serta dirancang
dan diorganisasikan supaya secara otomatis menerima dan menyimpan
data input, memprosesnya, dan menghasilkan output berdasarkan
instruksi-instruksi yang telah tersimpan di dalam memori.



Komputer mempunyai beberapa karakteristik:

1.

AN

Alat elektronik.

Dapat menerima input data.

Dapat mengolah data.

Dapat memberikan informasi.

Menggunakan suatu program yang tersimpan di memori komputer
(‘stored program).

Dapat menyimpan program dan hasil pengolahan

Bekerja secara otomatis

Sejarah Singkat Komputer
Dalam perkembangannya, komputer telah mengalami suatu evolusi yang

sangat berarti bagi peradaban manusia, berikut adalah sejarah singkat

mengenai komputer:

Komputer Generasi Pertama 1940-1956
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Perangkat komputer yang pertama ternyata dikembangkan

untuk desain pesawat dan peluru kendali. komputer generasi pertama

menggunakan tabung hampa udara sebagai sirkuit dan drum magnetik

untuk memori.

— Bahan Ajar Aplikasi Komputer



Komputer generasi pertama ini sangat mahal dan besar, hingga
mengisi seluruh ruangan. Dan mempunyai bobot 30 ton, panjang 30 M,
dan tinggi 2,4 M.

Komputer generasi pertama mengandalkan machine language, level
bahasa pemrograman paling rendah yang dimengerti komputer.

Komputer Generasi Kedua 1956-1963

Komputer Generasi Kedua muncul setelah ditemukannya transistor,
yang kemudian mulai mengganti tabung vakum dalam desain komputer.

Frizka Fitriana, S.Kom., M.Kom. _



Transistor jauh mengungguli tabung hampa dan memungkinkan
komputer menjadi lebih kecil, cepat, murah, dan hemat energi
dibandingkan dengan pendahulunya.

Komputer Generasi Ketiga 1964-1971

Pengembangan integrated circuit menjadi penanda komputer generasi
ketiga. Dalam pemakaian komputer generasi kedua, transistor membuat
komputer cepat panas, maka komputer generasi kedua mulai ditinggalkan

‘ Bahan Ajar Aplikasi Komputer



Kemudian pada tahun 1958 Jack Billy menciptakan integrated
circuit chip atau IC, kepingan kecil yang mampu menampung banyak
komponen menjadi satu. Komputer pada generasi ini menjadi lebih kecil
dan cepat serta murah, memungkinkan juga menjadi tersedia untuk
khalayak umum.

Komputer Generasi Keempat 1971-Sekarang

Komputer yang kita pakai sekarang merupakan komputer generasi
keempat, yang mana dibuat dengan menggunakan komponen dasar
bernama Microprosesor.

Intel menjadi sebuah perusahaan yang paling berpengaruh terhadap
perkembangan chip microprosesor karena mereka berhasil menciptakan
intel 4004 yang merupakan cikal bakal perkembangan komputer.

Banyak sekali kemajuan pesat yang terjadi pada generasi ini, seperti
diciptakannya mouse, hingga komputer jinjing yang disebut dengan
laptop. Bahkan prosesor atau CPU pun mengalami perkembangan dari
waktu ke waktu hingga sekarang.

Frizka Fitriana, S.Kom., M.Kom. _



Komputer Generasi Kelima Sekarang - Masa Depan

Generasi kelima ini sebenarnya masih tahap pembangunan, yang

mana generasi ini akan mempunyai teknologi yang dibuat berdasarkan

kecerdasan buatan (artificial intelligence).

Tugas

1. Dalam tugas ini, buatlah kelompok yang terdiri atas 3 orang.

2. Bayangkan kelompok Anda merupakan pegawai sebuah perusahaan.

3. Pada suatu waktu pimpinan perusahaan meminta kelompok Anda
untuk membuat ide baru untuk perkembangan komputer.

4. Silakan menentukan nama perusahaan, produk, dan cara kerja
komponen yang di buat.

5. Buatlah berupa makalah dan presentasikan di pertemuan yang

berikutnya.

‘ Bahan Ajar Aplikasi Komputer
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Manfaat Komputer

Apa Manfaat Komputer?
Di era serba digital, keberadaan komputer menjadi salah satu pendukung
mobilitas manusia yang lebih mudah. Segala sesuatu bisa dilakukan
secara mudah menggunakan perangkat elektronik yang telah berkembang
canggih ini.

Jika dulu komputer memiliki bentuk yang besar dilengkapi tabung
dan CPU, kini modernisasi membuat komputer bisa lebih praktis dalam
bentuk laptop atau notebook.

Berikut manfaat komputer dalam kehidupan manusia modern yang
bisa dimanfaatkan sesuai kebutuhan:

1. Komputer Sebagai Sarana Mempermudah Kerja
Komputer merupakan perangkat kerja yang memudahkan semua hal
termasuk menghemat waktu, biaya dan tenaga Anda.

Contohnya jika dahulu penulisan surat dilakukan menggunakan
mesin tik biasa, kini lebih mudah menggunakan aplikasi Microsoft
word. Sekarang bisa mengetik, mengedit dan menyimpan hasil kerja
tanpa harus takut melakukan kesalahan saat dicetak di kertas surat.

2. Komputer Bisa Menjadi Alat Hiburan
Memiliki komputer sangat membantu manusia yang ingin merelaksasi
pikiran dari kejenuhan harian. Bisa menonton film, mendengarkan



musik, bermain game dan berbagai jenis aplikasi yang bisa dimainkan
lewat komputer.

3. Komputer Bisa Menjadi Sarana Informasi
Melalui komputer yang terkoneksi internet, Bisa melakukan apa saja
termasuk belajar ilmu dan wawasan baru. Juga bisa mendapatkan
banyak referensi materi hinggga kemudahan info membangun
jaringan yang bermanfaat untuk pribadi atau usaha.

4. Bisa Menjadi Sarana Pendidikan
Manfaat paling baik dari alat canggih ini antara lain bisa menjadi
media pembelajaran di sekolah atau rumah. Tinggal unduh aplikasi
yang ingin dipelajari di komputer seperti power point, corel draw,
photoshop dan masih banyak aplikasi yang lain.

5. Komputer Bisa Menjadi Sarana Komunikasi
Menggunakan komputer dilengkapi dengan koneksi internet bisa
memberikan kemudahan di bidang komunikasi. Bisa melakukan
chatting, video call atau bisa mengirim dokumen dalam bentuk audio,
video atau teks.

Peran Komputer dalam Kehidupan Sehari-hari?

1. Bidang Pendidikan
Dengan adanya komputer mempermudah bagi pegawai administrasi
sekolah untuk membuat kurikulum pengajaran, jadwal pelajaran
sekolah, membuat daftar nama siswa, membuat daftar nilai siswa,
membuat absen siswa, membuat perhitungan gaji pegawai dan
membuat perencanaan pengajaran bagi guru-guru sekolah.

Mengakses Informasi Pendidikan lewat Internet. Seiring

perkembangan jaman Internet telah merambah sekolah-sekolah
setingkat kecamatan,sehingga akses informasipun semakin mudah
diperoleh untuk kemajuan pendidikan tiap-tiap sekolah.

_’ Bahan Ajar Aplikasi Komputer



2. Bidang Kesehatan
Mempermudah Dokter dan Perawat dalam memonitor kesehatan
pasien monitor detak jantung pasien lewat monitor komputer, aliran
darah, memeriksa organ dalam pasien dengan sinar X.

Sebagai contoh saat perawatan Almarhum Mantan Presiden
Soeharto di Rumah Sakit Pertamina Jakarta, tahun 2008.

Dengan teknologi modern bisa memonitor, bahkan menggantikan
fungsi organ dalam seperti Jantung, Paru-paru dan Ginjal. Itu
merupakan teknologi kesehatan yang digabungkan dengan teknologi
Informasi dan Komputer.

3. Bidang Transportasi
Dengan komputer semua jadwal dan jalur penerbangan yang transit
dibandara bisa di program dan dijadwalkan dengan komputer.
Untuk menerbangkan sendiri pesawat dilengkapi dengan peralatan
komputer.

Bahkan setelah mencapai ketinggian tertentu pesawat bisa di
terbangkan otomatis dengan pilot otomatis yang sudah diprogram
di dalam komputer.

Dengan komputer, narigasi kapal laut bisa ditentukan koordinat
dan arah gerak kapal. Demikian juga penjualan tiket di Bandara,
Stasiun, Dan Terminal Bus di layani dengan cepat menggunakan
komputer.

4. Bidang Barang dan Jasa
Kantor Pos bisa mengirimkan dokumen pengiriman barang lebih
cepat dan akurat. Dengan adanya komputer dan internet orang tidak
lagi menunggu berhari-hari menerima surat, cukup lewat email saja
lebih cepat dalam sekejap, jadi dunia menjadi semakin sempit dalam
arti bisa diakses sedemikian cepatnya.

Frizka Fitriana, S.Kom., M.Kom. _



5. Bidang Industri Otomotif
Mobil-mobil di buat dari kerangka body, mesin, peralatan elektronik
di pabrik dengan bantuan robot yang dikendalikan oleh komputer
dengan leih akurat.

Dengan bantuan komputer pabrik-pabrik otomotif bisa
memproduksi mobil dalam jumlah ratusan perbulan, yang tidak
mungkin dikerjakan secara manual dengan tenaga manusia.

6. Bidang Jasa Konstruksi
Dengan komputer para Insiyur dan Arsitek mendesain gambar
konstruksi dengan pemodelan dan perhitungan yang akurat, cepat
dan tepat.

Gambar kontruksi didesain menggunakan program CAD,
sedangkan untuk perhitungan analisis dan penganalisa kekuatan
menggunakan program SAP2000 atau STAD III yang dioperasikan
dengan bantuan komputer.

7. Bidang Industri Perfilman
Semua efek-efek di dunia akting, animasi, dan penyotingan adegan
film semua di rekam dengan perangkat elektronik yang dihubungkan
dengan komputer.

Animasinya juga di kembangkan mempergunakan animasi yang
dibuat dengan aplikasi komputer.

Sebagai contoh film-film Hollywood berjudul TITANIC itu
sebenarnya tambahan animasi untuk menggambarkan kapal raksasa
yang pecah dan tenggelam, sehingga tampak menjadi seolah-olah
mirip dengan kejadian nyata.

m Bahan Ajar Aplikasi Komputer
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Cara Kerja Komputer

Bagaimana cara kerja komputer?
Komputer menjalankan perintah secara berurutan, dengan data yang
terus-menerus berpindah dari input dan memori ke prosesor perangkat.

Saat ini, komputer melakukan pekerjaan yang dulunya rumit menjadi
lebih sederhana. Cara kerja komputer adalah mengambil informasi (input),
mengolah informasi (pemrosesan), menyimpan informasi (penyimpanan),

dan memuntahkan hasil (output).
Dengan penjelasan sebagai berikut:
1. Mengambil informasi (Input)
Mengambil informasi (input) merupakan tahap awal dari proses

pengolahan yang terjadi pada sistem komputer. Mengambil informasi
(input) Cara kerja komputer dimulai dengan mengambil informasi
(input).

Input komputer dilakukan oleh manusia sebagai pengguna (user).

Informasi dimasukkan oleh pengguna memalui perangkat input.

Perangkat input kemudian mengubah informasi menjadi data
digital yang dapat dipahami komputer yaitu bahasa biner 1 dan 0.
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2. Penyimpanan informasi (penyimpanan)
Setelah informasi diinput, informasi akan disimpan sebagai memori
oleh komputer. Ada dua jenis komponen penyimpanan dalam
komputer yaitu RAM (Random Access Memory) dan juga memori
persisten.

Memori yang baru diinput biasanya disimpan dalam RAM,
karena RAM adalah penyimpan data yang sedak aktif. RAM bekerja
sangat cepat, ia dapat menyimpan 1 byte data hanya dalam waktu 1
nano detik saja.

Semua pekerjaan yang sedang dilakukan komputer secara aktif
disimpan dalam RAM. Misalnya saat sedang mengetik, teks tersebut
disimpan dahulu dalam RAM atau saat sedang membuka tab browser,
semua tab yang sedang dibuka disimpan dalam RAM.

3. Mengolah informasi (pemrosesan)
Data input yang disimpan dalam RAM tersebut kemudian bisa diolah
oleh CPU sebagai otak dari komputer. Segala macam perintah yang
diinput secara dioleh CPU dengan bantuan dari RAM.

Hal tersebut karena CPU tidak memiliki memori, artinya CPU
tidak mengingat atau menyimpan apapun. Sehingga semua data yang
diproses CPU secara actual diambil dari RAM.

4. Menyimpan informasi (penyimpanan)

Setelah data selesai diolah, baru kemudian data dapat disimpan secara
permanen dalam memori persisten. Pengertian dan Manfaatnya
Contoh memori persisten adalah hard disk dan juga flash drive.
Dalam memori persisten data byte akan disimpan dalam bentuk
file atau folder atau informasi dapat disimpan dalam waktu lama
dan dapat diakses lagi sewaktu-waktu oleh pengguna. Penyimpanan
resisten inilah yang memungkinkan kita menyimpan foto, video, fil,
dan folder dalam format apapun di komputer.
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Mengaktifkan/menghidupkan komputer:

Langkah-langkah untuk menghidupkan komputer adalah:

1. Pastikan semua peralatan komputer tersambung dengan benar
termasuk penggunaan arus listrik

2. Lakukan pengecekan pada Floppy Drive, harus dalam keadaan kosong
(kalau ada)

3. Nyalakan komputer dengan menekan tombol Power pada monitor
dan CPU, kemudian tunggu sampai komputer selesai melakukan
booting.

4. Setelah proses booting selesai, komputer akan menampilkan desktop.

Cara Kerja Komputer Saat Dinyalakan:

Ketika kita pertama kali menyalakan komputer, tentu saja mesin akan
melewati beberapa proses internal sebelum komputer siap untuk
digunakan. Proses internal ini di sebut proses boot.

Boot merupakan singkatan dari bootstrap yang prosesnya ini
dikendalikan oleh sistem input output dasar yaitu BIOS.

BIOS merupakan perangkat lunak yang tersimpan di chip flash
memory. BIOS ini tertanam di mainboard, selain mengendalikan proses
booting perangkat keras ini juga menyediakan user interface konfigurasi
dasar untuk hardware komputer.

Pada user interface tersebut kita bisa mengkonfigurasikan beberapa
hal seperti urutan membaca drive ketika booting dan juga seberapa cepat
prosesor yang harus dibiarkan berjalan.

Cara Kerja Komputer Pada Saat Booting

1. Saat tombol turn on atau turn off ditekan, maka komputer akan
mengirimkan daya menuju ke mainboard dan juga komponen lain.

2. PC akan melakukan POST atau Power On Self Test. Dimana POST
ini merupakan program komputer kecil yang terdapat pada BIOS
yang memeriksa kegagalan pada perangkat keras. Biasanya saat
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komputer dinyalakan ini BIOS akan memberikan suara satu bip
yang memberikan sinyal semuanya baik-baik saja.

3. PC akan menampilkan informasi di monitor dengan menunjukan
detail tentang proses dari booting. Hal ini termasuk juga produsen
serta revisi BIOS, jumlah RAM, spesifikasi Processor dan juga drive
yang terdeteksi.

4. BIOS akan mencoba mengakses sektor pertama dari drive yang
menjadi disk boot. Sektor pertama ini merupakan kilobyte pertama
yang secara berurutan, apabila drive dibaca secara berurutan dimulai
dengan alamat penyimpanan yang tersedia pertama.

5. BIOS nantinya akan mengkonfirmasi jika terdapat bootstrap loader.
Pada sektor pertama dari disk boot ini membuat boot loader ke dalam
memori atau RAM.

6. Selanjutnya setelah boot loader berada di memori, BIOS akan
menyerahkan pekerjaan ke boot loader yang selanjutnya akan memuat
sistem operasi.

7. Saat bootloader menyelesaikan tugasnya, hal tersebut akan
mengalihkan kendali PC ke dalam sistem operasi.

Cara Kerja Komputer Pada Sistem Operasi:
Setelah PC menyelesaikan proses Booting, kita bisa mengontrol perangkat
hardware yang membentuk komputer tersebut.

Kebanyakan komputer di Indonesia ini menggunakan sistem operasi
Windows. Sistem operasi Windows ini dibuat untuk menghubungkan
perangkat keras dengan pengguna. Sistem operasi pada komputer ini
bertanggung jawab terhadap beberapa tugas seperti:

1. Memecahkan pekerjaan prosesor untuk menjadi potongan yang bisa
dikelola serta memprioritaskannya sebelum mengirim ke CPU.

2. Mengkoordinasikan aliran data yang masuk dan juga yang keluar dari
RAM, kemudian menentukan kapan waktunya untuk menggunakan
memori virtual di harddisk untuk menambahkan jumlah RAM jika
tidak mencukupi.
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Menyediakan antarmuka yang berbasis perangkat lunak antar
komponen dan juga setiap perangkat yang terhubung menuju
komputer. Misalnya seperti menerjemahkan input keyboard dan
menyesuaikan data grafik dengan layar monitor.

Mengarahkan tempat data yang harus disimpan dengan permanen
di hardisk. Tugas lainnya seperti membaca, membuat, menyalin atau
memindahkan serta menghapus dokumen.

Menyediakan pertukaran data dari program perangkat lunak dan juga
PC. Aplikasi harus disetting agar bisa berguna dengan user interface
sistem operasi yang digunakan.

Menjembatani antara pengguna dengan hardware dari komputer,
artinya sistem operasi ini bertanggung jawab agar setiap hardware
bisa berjalan dan juga digunakan oleh pengguna.

Mematikan komputer dengan prosedur yang benar:
Langkah-langkah untuk mematikan komputer adalah:

1.
2.
3.

Klik menu Start

Pilih Turn Off Computer
Akan muncuk kotak dialog:
Dengan penjelasan:

Stand By: Mengistirahatkan komputer tapi komputer dalam
keadaan hidup

Turn Off: Mematikan komputer

Restart: Membooting ulang

o a0 o

Cancel: Membatalkan perintah untuk mematikan komputer

Untuk mengakhiri penggunaan komputer klik Turn Off.
Matikan monitor dengan menekan tombol Power.
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Perangkat keras

Penjelasan:

1. Power Supply (Sumber Daya Listrik)

2. CD-ROM/DVDROM Drive (Mampu membaca DVD/CD)

3. Hard Drive (Penyimpanan Data Sekunder dan berisi Piringan
Magnetis)

4. Floppy Drive (Media penyimpanan yang terdiri dari media
penyimpanan magnetis tipis dan fleksibel).

5. Disk Controllers (Meneruskan data dan intruksi ke Disk Drive).

6. Expansion Slot (Intergrasi dari Circuit Boards ke Mother Board).

7. Video Card (Menerjemahkan informasi gambar ke dalam berbagai
arus listrik yang diperlukan untuk menampilkan gambar pada
monitor).

8. Sound Card (Merekam dan Mereproduksi suara multimedia).
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10.

11.

12.

13.

14.

15.
16.

17.
18.
19.
20.
21.
22.
23.

24,

RAM (kumpulan microchip yang diluruskan pada papan sirkuit kecil
yang masuk ke dalam slot dengan beberapa ratus atau lebih konektor)
Real-Time Clock (komponen ini adalah drummer yang mengatur
langkah dan menyinkronkan pekerjaan semua komponen lainnya).

CMOS (Chip memori khusus yang menggunakan baterai kecil untuk
menyimpan informasi tentang konfigurasi perangkat keras PC Anda
bahkan ketika komputer dimatikan).

BIOS (Chip yang menentukan kepribadian, atau individualitas, dari
Komputer).

CMOS Battery (Baterai yang digunakan oleh BIOS untuk tetap aktif
meski tanpa aliran listrik).

Microprocessor (Kumpulan transistor yang rapat dan rumit yang
diatur sehingga mereka dapat digunakan untuk memanipulasi data).
Heat Sink (Pendingin).

Fan (mengeluarkan panas dan menggantinya dengan udara segar ke
dalam sistem).

Usb Ports (Perangkat Penghubung).

Mouse Ports (konektor Input/Output).

Keyboard Port(konektor Input/Output).

Network Connector(konektor PC pada sebuah jaringan).

Parallel Port (konektor PC pada printer atau driver lainnya).

Serial Ports (konektor Input/Output).

Sound Card Connection (Soket Eksternal untuk memasang mikrofon,
speaker atau sumber daya eksternal).

Modem (Penghubung PC ke saluran telepon sehingga dapat
mengakses layanan informasi dan internet).
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Bab IV

Sistem Operasi / Operating
System (OS)

Sistem Operasi adalah?

Sistem Operasi (OS) merupakan perangkat lunak bertindak sebagai
antarmuka antara pengguna komputer dan perangkat keras komputer serta
mengontrol pelaksanaan semua jenis program, termasuk menjalankan
perangkat lunak aplikasi seperti program-program pengolah kata,
penjelajah web, dll..

Tujuan SO

Tujuan dari sistem operasi adalah mengontrol eksekusi program-program
aplikasi dan juga sebagai interface antara pengguna komputer dan
hardware komputer.

Namun, secara umum sistem operasi memiliki tiga tujuan dasar:

1. Efisiensi: sistem operasi memungkinan sumber daya sistem komputer
untuk digunakan dengan cara yang efisien.
Kemudahan: sistem operasi membuat komputer lebih mudah dipakai.

3. Kemampuan berevolusi: sistem operasi harus disusun sedemikian
rupa sehingga memungkinkan pengembangan yang efektif, pengujian,
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dan beberapa fungsi sistem yang baru tanpa mengganggu layanan
yang telah ada.

Fungsi Dasar Sistem Operasi

1. Menjembatani hubungan antara hardware dan program aplikasi yang
dijalankan user.

2. Mengatur dan mengawasi penggunaan perangkat keras oleh user dan
berbagai program aplikasi (Resource Allocator).

3. Sebagai program pengendali yang bertujuan untuk menghindari
kekeliruan (error) dan pengguna komputer yang tidak perlu sebagai
guardian yang menjaga komputer dari berbagai kemungkinan
kerusakan.

4. Manajer sumber daya hardware, seperti mengatur memori, printer,
CD ROM, dIL

Komponen utama SO

1. Kernel: Merupakan suatu software yang membentuk sistem dan
memiliki tugas melayani bermacam-macam program aplikasi untuk
mengakses hardware komputer secara aman dan terkendali.

2. File: file di sini merupakan file-file yang dibentuk atau dijalankan oleh
sistem operasi. File juga di sini berarti sitem berkas dan file sistem
yang dimiliki oleh suatu sistem operasi.

3. User interface: sebuah sistem operasi memliki karakteristik interface
yang memiliki interaksi antara user dengan komputer. Bentuk umum
user interface yang ada adalah:

a. Command line interface atau command line interpreter (CLI)
b. Graphical user interface

Jenis Sistem Operasi

Sistem operasi dapat dibedakan berdasarkan jumlah pengguna program
yang dapat dijalankan, juga berdasarkan jenis software atau jenis hardware
yang digunakan.
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Komputer

1. DOS

2. Windows

3. Linux

4. MacOS

Smartphone / Handphone
1. Java

2. Symbian

3. Blackberry

4. Android

5. IOs

Berdasarkan jumlah penggunaan dan program yang dijalankan,
sistem operasi dapat dikategorikan dengan:

1. Single User - Single Tasking: satu komputer hanya bisa digunakan
oleh satu user dan hanya bisa menjalankan satu program di satu
waktu, contohnya DOS (Disk Operating System).

2. 5 Multi User - Single Tasking: satu kompuetr dapat digunakan oleh
banyak user namun tiap user hanya bisa menjalankan satu program
(aplikasi) di satu waktu, contohnya Novell Netware yang menjalankan
SO Network berbasis DR-DOS.

3. Single User — Multi Tasking: satu komputer dipakai oleh satu user
dan dapat menjalankan banyak program di satu waktu, contohnya:
Windows, MacOS, BeOS, JDS, dll.

4. Multi User - Multi tasking: satu komputer dipakai bersamaan oleh
banyak user yang dapat menjalankan banyak program di satu waktu,
contohnya: Unix, Linux, FreeBSD, (SO turunan Unix) atau Windows
dengan aplikasi Citrix Metaframe, dIL

Dos
1. Sistem Operasi DOS adalah DOS (Disk Operating System ) merupakan
salah satu software yang termasuk dalam golongan system operasi.
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Disk Operating System dipakai pada media penyimpan disk, baik
disket maupun harddisk
2. Beberapa produk DOS sampai saat ini adalah:
DOS 1.0
DOS 2.0
DOS 3.0: DOS 3.1, DOS 3.2 dan DOS 3.3
DOS 4.0
DOS 5.0
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Windows

Windows adalah salah satu software sistem operasi yang dikeluarkan
oleh perusahaan Microsoft Inc. Microsoft Windows adalah software
sistem informasi yang paling populer untuk para pengguna PC. Tampilan
Windows yang “user friendly” membuatnya menjadi pilihan utama.
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Wlndows 8

Macam-macam windows:

Ms-Dos (1980-1984)

Windows 1.0 — Windows 1.04 (1985-1987)
Windows 2.0 (1987)

Windows 3.0 (1990)

Windows NT 3.1 (1992)

Windows for Workgroups 3.11 (1993)
Windows NT Workstation 3.5 (1994)
Windows 95 (1995)

Windows NT Workstation 4.0 (1996)
Windows 98 (1998)

. Windows 98 Second Edition (1999)
Windows Millennium Edition (Windows Me) (2000)
Windows 2000 Profesional (2000)
Windows 2000 Server

Windows XP (2001)

Windows Vista (2006)

Windows 7

Windows 8

Windows 10
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Mac OS
Mac OS adalah sistem operasi yang dibuat oleh Apple. Sistem operasi ini
sudah terpasang pada semua komputer Macintosh (disebut Mac) baru.

Berdasarkan StatCounter Global Stats, pangsa pasar pengguna sistem
operasi Mac OS kurang dari 10 persen dari pengguna global sistem operasi.
Statistik ini jauh lebih rendah dari persentase pengguna sistem operasi
Windows (lebih dari 80 persen).

Salah satu penyebabnya adalah bahwa harga komputer Apple
cenderung lebih mahal. Namun, banyak orang lebih menyukai tampilan
sistem operasi Mac OS X daripada Windows.

Linux

Linux (diucapkan LINN-ux) adalah jenis sistem operasi open-source, yang
kode programnya (source code) dapat dimodifikasi dan didistribusikan
oleh siapa saja di seluruh dunia.

Sistem operasi Linux berbeda dari sistem operasi Windows yang
bersifat proprietary (modifikasi kode program hanya dapat dilakukan oleh
perusahaan pencipta Windows). Beberapa keuntungan Linux adalah gratis
dan tersedia banyak varian Linux yang dapat di pilih sesuai keinginan.

Android

anN>o=0ID
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1. Android dengan logo uniknya yaitu “Robot Ijo” sebetulnya sudah
ada sejak lama, namun semenjak tahun 2009 perkembangan Android
melesat dengan cepat.

2. Mobile OS dari Google ini memberikan kebebasan yang sangat
luas untuk para developer dan terintegrasi penuh dengan teknologi
Google.

3. Aplikasi-aplikasi yang tersedia untuk Android juga sudah banyak
sekali sehingga pengguna Android mempunyai banyak variasi dalam
menggunakan aplikasi di Android.

Jelaskan Cara Kerja Sistem Operasi?

Pengguna

I'

Aplikasi

] <

[ S p—————
215lem operasl
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Bab Vv

Microsoft Word

Pengenalan Microsoft Word

Microsoft Word merupakan program aplikasi pengolah kata (word
processor) yang yang biasa digunakan untuk membuat laporan, dokumen
berbentuk surat kabar, label surat, membuat tabel pada dokumen.

Program Microsoft Word merupakan paket program yang termasuk
dalam kelompok Word Processing ( pengolahan kata ).

Program ini menjadi satu paket kedalam Microsoft office. Dalam
materi ini kita akan mempelajari Microsoft Word.

Sebetulnya masih ada lagi program pengolah kata yang beredar
di Indonesia antara lain Word Perfect, WordStar, Chiwriter, WordPad,
NotePad dll.

Memulai Word

Microsoft Office Word dapat dibuka dengan menggunakan beberapa
cara yang berbeda. Jika icon Microsoft Word terdapat pada Desktop atau
melalui tombol Start, dapat dibuka dengan menggunakan dobel klik pada
icon tersebut untuk membuka layar Excel
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Menjalankan dari Start

1.

2.
3.
4

Klik tombol Start

Pilih All Programs

Pilih Microsoft Office

Pilih dan klik Microsoft Ofice Word

O | @& Modul Ajar Aplikasi Komputerp: X | (@ Bahan_Ajar Aplikesi Komputere x|

O (:) File | E:/Politeknik%%20Sampit/Aplikasi%20Komputer/Bahan_Ajar_Aplikasi_Kempu

Microsoft OneNote 2010 Productivity

Microsoft Outiock 2010 o3 i LiNa
[———

Microsoft PowerPoint 2010

Microsoft Publisher 2010

BB Microsoft SharePoint Workspace 2010

@ Microsoft Word 2010 » E

I Microscft SQL Server 2008 v Microsoft Edge Microsoft Store

I Microscft SQL Server 2014

B Microsoft Store

Microscft To Do
% \fixed Reality Portal
b Movies & TV
B wysa
N
= News

o

Akses MS Word dari Start > Programs

Atau

Menggunakan icon Microsoft Word terdapat pada Desktop

Setelah tereksekusi maka aplikasi MS Word akan dijalankan dan

menampilkan lingkungan kerja sebagai berikut:
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Identifikasi Lembar Kerja Microsoft Word

1. File Menu (Backstage)
Klik tombol File untuk melihat menu Backstage. Pengguna dapat
menyimpan, mencetak, atau berbagi file; memodifikasi pilihan Word,
dan keluar dari program.

2. Quick Access Tollbar
Toolbar khusus ini menyediakan akses cepat ke perintah yang paling
sering digunakan.

3. Tittle Bar
Nama dokumen akan muncul di sini, serta nama program.

4.  Windows Controls
Dari kiri ke kanan, ini adalah Minimixe, Maximize / Restore, dan
Close.

5. Tabs
Klik nama tab untuk melihat perintah khusus untuk nama tab tersebut.
Misalnya, tab Page Layout memungkinkan Anda mengubah ukuran

kertas, margin, pengaturan paragraf, dan banyak lagi. Area perintah
di bawah tab dikenal sebagai Ribbon.

Frizka Fitriana, S.Kom., M.Kom. _



6. Minimize Ribbon dan Icon Help
Klik panah kecil di sisi kanan dari jendela untuk menyembunyikan
pita.Klik icon tanda tanya biru untuk membuka jendela dialog
Bantuan.

7. Groups
Perintah-perintah pada setiap tab dipisahkan ke dalam kelompok.
Kelompok ini menyediakan perintah untuk mengubah ukuran,
melihat, dan orientasi dari sebuah paragraf.Kadang-kadang, di sudut
kanan bawah grup, terlihat tombol pilihan.

8. Working Area
Ini adalah tempat mengisi dokumen dengan ketikan

9. Scroll Bar
Scroll bar memungkinkan untuk mencari bagian dari dokumen.
Klik panah atas / bawah pada setiap akhir scroll bar untuk bergerak
ke arah itu, atau klik dan tarik scroll marker untuk bergerak cepat
melalui dokumen. Jika mouse Anda dilengkapi dengan scroll, putar
roda ke atas atau bawah untuk menggulirkan layar.

Diperhatikan juga bahwa jika memperbesar dokumen dan lebar
halaman melebihi lebar jendela Word, akan terlihat horizontal scroll
bar yang muncul didekat status bar. Gunakan ini untuk bergulir dari
sisi kiri ke sisi kanan atau sebaliknya

10. Status Bar
Status bar memberikan informasi tentang dokumen tersebut. Status
bar juga menunjukkan halaman atau jumlah total halaman, berapa
banyak kata dokumen tersebut, view apa yang saat ini sedang
digunakan, dan level zoom saat ini.

Fungsi Sub Menu Pada Menu Bar

Semua menu yang terdapat pada menu utama Microsoft word memiliki
submenu yang mempunyai fungsi masing-masing sesuai dengan
kelompoknya. Untuk lebih memudahkan kita bahas satu persatu.
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1.

2.

Ikon dan Sub Menu Dari menu File

Tom-
Sub Menu Fungsinya
bol
New Ctrl+N | Membuat dokumen baru
Open Ctrl+O | Untuk membuka dokumen yang tersimpan
Close Alt+F4 | Untuk menutup dokumen yang aktif
Save Ctrl+S | Untuk menyimpan dokumen aktif
Save As Untuk menyimpan dokumen yang belum diberi
nama dan
diberi kesempatan mengganti nama file
Save as Web Untuk menyimpan dokumen dalam bentuk htm
Page
File Search Untuk mencari dokumen
Page Setup Untuk mengatur halaman yang akan dicetak
Print Preview Untuk melihat tampilan dokumen sebelum dice-
tak
Print Ctrl+P | Untuk mencetak dokumen dan juga untuk men-
gatur
halaman
Send To Untuk mengirimkan dokumen
Properties Untuk membuat rangkuman dari dokumen yang
aktif
Exit Untuk keluar dari word dan menutup seluruh do-

kumen

Ikon dan Sub Menu Dari menu Edit

Tom-
Sub Menu Fungsinya
bol
Undo Ctrl+Z | Untuk membatalkan perintah yang telah dilaku-
kan
Redo Ctrl+Y |Untuk mengulangi perintah terakhir yang
pernah dibatalkan dengan Undo
Repeat Untuk mengulangi perintah yang telah dilakukan
Cut Ctrl+X |Untuk memotong atau menghapus teks atau

gambar dan

disimpan dalam clipboard
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Copy Ctrl+C | Untuk mengcopy atau menyalin file, teks atau
gambar yang
disimpan dalam clipboard

Paste Ctrl+V | Untuk menampilkan teks atau gambar yang tel-
ah dicopy
atau di cut

Select All Ctrl+A |Untuk memilih/menyorot seluruh teks atau
gambar yang
akan diolah

Find Ctrl+F | Untuk mencari teks atau kata dalam dokumen

Repleace Ctrl+H | Untuk mengubah teks atau kata dalam dokumen

Go To Ctrl+G | Untuk menuju ke halaman, footnote, endonote
atau bagaian
lain yang ada dalam dokumen

Ikon dan Sub Menu Dari menu View

Sub Menu | Tombol Fungsinya

Normal Mengubah penampilan layar pengetikan dalam
mode
normal

Web layout Mengubah penampilan layar pengetikan dalam
bentuk web
view

Outline Mengubah penampilan layar pengetikan dalam
bentuk
outline

Print Layout Mengubah penampilan layar pengetikan dalam
bentuk Print
View

Taks Pane Ctrl+F1 | Untuk menampilkan dan menghilangkan taks
pane

Toolbars Untuk menampilkan dan menghilangkan toolbars

Ruler Untuk menampilkan dan menghilangkan garis

pengatur
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Header and

Footer

Untuk membuat judul di atas (header) dan mem-
buat judul di
bawah (footer)

Full screen

Untuk menampilkan dokumen dalam satu layer

penuh
Magnifier Untuk menampilkan dokumen berdasarkan pili-
han pembesaran layar
Zoom Untuk menentukan ukuran tampilan layar
yang ditampilkan
Ikon dan Sub Menu Dari menu Insert
Tom-
Sub Menu Fungsinya
bol
Page Break Untuk menyisipkan belahan halaman
Page Number Untuk menyisipkan nomor halaman baik di atas
maupun di
bawah
Date and Time Untuk meyisipkan tanggal dan jam dalam doku-
men
Symbol Untuk menyisipkan symbol ke dalam dokumen
Footnote Untuk menyisipkan catatan kaki dalam dokumen
Boolmark Untuk menyisipkan tanda pada teks atau gam-
bar, grafik
atau lainnya ke dalam dokumen
Hyperlink Ctrl+K | Untuk menyisipkan teks hyperlink pada lembar
kerja yang berguna untuk dalam pembuatan
shortcut dalampembukaan dokumen yang tersim-
pan di internet, jaringan
Tekx Box Untuk menyisipkan tek atau gambar pada kotak
dalam
dokumen
File Untuk menyisipkan suatu file ke dalam dokumen
Insert Excel Untuk menyisipkan lembar kerja excel kedalam
Spreadshhet dokumen
word
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Diagram Untuk menyisipkan digram/grafik kedalam doku-
men

WordArt Untuk menyisipkan teks yang mengandung seni
kedalam
dokumen

ClipArt Untuk menyisipkan gambar ClipArt melalui Mic-
rosoft ClipArt
Gallery kedalam dokumen

Object Untuk menyisipkan objek ke dalam dokumen

Autoshapes Untuk menyisipkan gambar tertentu dari tollbar

kedalam

dokumen

Equation Ed-

Untuk menyisipkan rumus matematika kedalam

itor dokumen
Ikon dan Sub Menu Dari menu Format
Tom-
Sub Menu Fungsinya
bol
Font Untuk memilih jenis huruf yang diinginkan
Paragraph Untuk menentukan indentasi, spasi, spasi antar
paragraph
dalam dokumen
Bullets and Untuk menyisipkan bullets dan nomor pada
Numbering teks yang
terpilih dalam dokumen
Border and Untuk membuat border atau bingkai
Shading
Column Untuk membuat dokumen menjadi beberapa
kolom atau
membuat seperti kolom Koran
Tab Untuk menentukan posisi dari tempat berhentin-
ya tabulasi
(tab) dalam dokumen
Drop Cap Untuk membuat huruf pertama pada teks ataupun

paragraph menjadi huruf yang besar.

Text Direction

Untuk merubah orientasi teks pada dokumen
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Change Case

Untuk merubah teks menjadi huruf besar
semua, kecil

semua, huruf besar pada tiap kata atau sebaliknya

Background Untuk memberi warna belakang pada lembar
kerja yang
aktif
Ikon dan Sub Menu Dari menu Tools
Sub Menu Tom- Fungsinya
bol
Spelling and Untuk menjalankan fasilitas pemeriksaan ejaan
Grammar dan tata
bahasa dari teks atau paragraph
Dictionary Untuk menjalankan fasilitas kamus dalam doku-
men
Grammar Untuk pengaturan tata bahasa dalam dokumen
Word Count Untuk memberikan data statistic tentang jum-
lah halaman,kata, karakter, paragraph atau baris
pada dokumen yang
aktif
AutoCorrect Untuk memperbaiki teks secara otomatis
Track Change Untuk melihat pengubahan pada dokumen
yang telah
dilakukan, menerima atau menolak pengubahan
yang telahdilakukan
Compare Untuk membandingkan dokumen yang aktif
Documents dengan
dokumen lainnya
Merge Docu- Untuk menggabungkan dokumen aktif yang tel-
ments ah diubaholeh track changes ke dalam dokumen
yang telah
dispesifikasikan
Protect Untuk melindungi dokumen agar aman dari
Documents pengubahan didalam dokumen
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7.

Ikon dan Sub Menu Dari menu Table

Tom-
Sub Menu Fungsinya
bol
Insert Untuk menyisipkan table baru ke dalam doku-
men, menyisipkan kolom baris serta sel
Delete Table Untuk menghapus table
Delete Rows Untuk menghapus baris
Delete Col- Untuk menghapus kolom
umn
Delete Cells Untuk menghapus sel
Select Tabel Untuk memilih atau menyeleksi table

Select Rows

Untuk memilih atau menyeleksi baris

Select Column

Untuk memilih atau menyeleksi kolom

Select Cells Untuk memilih atau menyeleksi sel
TableAutoFor- Untuk membuat format table secara otomatis
mat
Merge Cells Untuk menggabungkan beberapa kolom atau
baris
Split Cells Untuk membagi kolom menjadi beberapa baris
dan kolom
Split Table Untuk membagi table menjadi dua table
Sort Untuk mensortir data atau mengurutkan data
Formula Untuk memasukkan rumus dalam melakukan
perhitungan pada table
Hide Gridlines Untuk menampilkan atau menyembunyikan garis
Bantu
Ikon dan Sub Menu Dari menu Window dan Help
Tom-
Sub Menu Fungsinya
bol
New window Untuk memperlihatkan dokumen yang sama da-
lam jendela yang berbeda
Arrange All Untuk mengatur jendela dari dokumen aktif agar

dapat melihat seluruh dokumen aktif dalam wak-

tu yang sama
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Split Untuk membagi menjadi dua bagianpada doku-
men aktif, agar dapat melihat bagian yang berbe-

da pada waktu yang sama

About Micro- Untuk menampilkan kotak dialog tentang Mic-

soft Word rosoft word yang kalian gunakan dan seterusnya.

Fungsi lkon Pada Toolbar Standart

Nama
Ikon Kegunaan
Tombol
New Blank

__j Docu- Untuk membuat dokumen baru

' ments

ﬁ Open Untuk membuka dokumen yang tersimpan

H Save Untuk menyimpan dokumen yang masih aktif

.. |Untuk mengaktitkan & dan menonaktifkan network

._a Permission . .
ety dari satu komputer dengan komputer lain

=il |e-Mail Untuk mengirinkan data melalui e-mail

|ﬂ Print Mencetak dokumen / data

Print

._;l | ) Melihat dokumen sebelum dicetak
L5 |preview

A:("y Soelli Untuk mengecek kebenaran pengejaan tulisn yang sudah

ellin

= PEINE | diketiksesuai dengan bahasa yang sudah kita setting

ﬁ Research | Untuk mencari file atau dokumen yang diinginkan

=

* Cut Mengggunti obyek

—|='f] Copy Membuat duplikat

I Paste
lﬂ Mengambil data dari clipboard setelah di copy atau dicut
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Format

Painter

Mengcopy format yang sudah diketik

i) Undo Membatalkan perintah
e Redo Mengembalikan setelah di ndo
% Hyperlink | Untuk menyisipkan hyperlink
Table and
._J' Untuk membuat table dan border
Border
I Insert Ta-
o= i bl Untuk menyisipkan table pada dokumen
e
= Insert Mic-
:_@ Untuk menyisipkan lembar kerja Excel ke dalam dokumen
_. | rosoftExcel
Microsoft Word
Worksheet
EE Column | Untuk membuat kolom koran
Chart o
| ﬂ . Menyisipkan grafik / membuat grafik pada dokumen
= |wizard

Zoom

Untuk mengatur tampilan dokumen

Fungsi lkon Pada Toolbar Formatting

Nama
Ikon Kegunaan
Tombol
: Arial | Font Memilih jenis atau bentuk huruf / font

10 = |FontSize |Memilih ukuran huruf/ font

B Bold Membuat huruf tebal

I Italic Membuat huruf miring

I Underline | Membuat huruf bergaris bawah
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% Align left | Meletakkan data rata kiri sel

= |Center Meletakkan data di tengah sel

— | Align

= ] Meletakkan data rata kanan sel

— | Right

= |Justify Untuk membuat teks, paragraph rata kiri dan kanan
# — |Line Spac- ) ) )

= . Untuk mengatur jarak spasi antar baris
L ing

L — | Number- . .

A |. Untuk membuat memberi nomor para baris / paragraph

ing

 —

= — |Bullets Untuk memberikan symbol pada baris / paragraf
——— |Decrease

== | Mengurangi Indentasi

=5 indent

—— | Increase

= | Menambah Indentasi

= indent

Eﬂ 1 |Borders Memberi borders / garis pada tabel

E!_:'..-? Fill color | Memberi warna pada background

i * | Font color | Memberi warna pada huruf / font

Fungsi lkon Pada Toolbar Drawing

Nama

Ikon Kegunaan
Tombol

bag Select Untuk memilih obyek

Autoshapes » Untuk menggambar Autoshapes

Nama

Ikon Kegunaan
Tombol

M Line Untuk membuat/menggambar garis
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1"" Arrow Untuk membuat atau menggambar panah

I:l Rectangle | Untuk menggambar kotak

C:] Oval Untuk menggambar lingkaran

(A= Untuk menyisipkan tek atau gambar pada kotak dalam

: Text Box
dokumen
ﬂ Insert Untuk menyisipkan teks yang mengandung seni dalam
| | WordArt |dokumen

o e Insert Dia- | Untuk menyisipkan diagram arganisasi ke dalam doku-

Lo gram men

I_E Insert Cli- | Untuk menyisipkan gambar ClipArt melalui ClipArt
i pArt Gallerykedalam dokumen

I Insert Pic- . .

tﬁ . Untuk menyisipkan gambar melalui kedalam dokumen

ure

‘{'!.::‘ Fill Color | Untuk memberi warna pada obyek gambar

=il Line Color | Untuk memberi warna pada gambar garis

é Font Color | Untuk memberi warna pada huruf atau font

— Line Style | Untuk memilih bentuk gambar garis

==== | Dash Style | Untuk memilih model garis

= MY nk ti bentuk gambar panah

ntuk menganti ben mbar pan
> Style uk menganti bentuk gambar pana
Shadow .
Ili Stvl Untuk memberikan shadow pada obyek gambar
yle
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j 3-D Style | Untuk memilih bentuk gambar 3 dimensi

Editing Naskah
Melakukan editing pada naskah dapat dilakukan dengan mudah seperti
melakukan perbaikan teks, menghapus teks, menyisipkan teks, memin-
dahkan teks bahkan menyalin teks, kalimat atau paragraf dari satu posisi
ke posisi lainnya.
1. Cara click pada mouse
a. Single click: menekan tombol mouse satu kali (tekan + lepas).
b. Double click: menekan dengan cepat tombol mouse sebanyak 2
kali (tekan + lepas + tekan +lepas)
c. 3. Hold click: menekan tombol mouse lalu ditahan beberapa
waktu kemudian dilepas untuk mengakhirinya (tekan + tahan
+ lepas)
2. Menempatkan kursor pada posisi tertentu
a.  Geser penunjuk mouse pada posisi yang akan ditempatkan kursor
b. Lakukan single click pada posisi tersebut

3. Menandai teks / Membuat Blok pada teks
a. Tempatkan kursor pada awal teks yang akan diblok
b. Lakukan hold click sambil menggeser mouse hingga akhir teks
yang akan diblok
4. Menghilangkan tanda blok pada teks dengan cara click pada
sembarang tempat/posisi.
5.  Menghapus teks
a.  Untuk menghapus satu karakter arahkan kursor pada teks yang
akan dihapus
b. Tombol Backspace: Digunakan untuk menghapus karakter yang
terletak di belakang kursor
c.  Tombol Delete: Untuk menghapus karakter yang berada di depan
posisi kursor
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d. Menghapus lebih dari satu karakter sekaligus Blok teks yang akan
dihapus Tekan tombol Delete

6. Memperbaiki teks
a. Tempatkan kursor pada teks yang akan diperbaiki
b. Hapus karakter yang akan diperbaiki
c. Ketik teks yang menjadi perbaikannya

7. Menyisipkan teks
a. Tempatkan kursor pada posisi yang akan disisipkan teks baru
b. Ketiklah teks yang menjadi sisipannya

8. Mengganti satu blok teks
a. Blok teks yang akan diganti
b. Tulislah teks baru

9. Menyalin teks dari satu posisi ke posisi lainnya
a. Buatlah blok pada teks yang akan disalin
b. Click Copy pada Clipboard Group di Home Tab atau tekan Ctrl
+C
c. Letakkan kursor pada posisi yang akan ditempatkan salinan teks
tersebut
d. Click Paste pada Clipboard Group di Home Tab atau tekan Ctrl
+V
10. Memindahkan teks dari satu posisi ke posisi lainnya
a. Buatlah blok pada teks yang akan dipindahkan
b. Click Cut pada Clipboard Group di Home Tab atau tekan Ctr]l + X
c. Letakkan kursor pada posisi yang akan ditempatkan teks tersebut
d. Click Paste pada Clipboard Group di Home Tab atau tekan Ctrl
+V

Membuat Table

Untuk membuat table biasanya kita lebih mudah dengan menggunakan
Microsoft Excel. Akan tetapi Microsoft Word juga menyediakan fasilitas
untuk membuat sebuah table. Dimana dalam pembuatan table-nya
terhitung lebih mudah daripada dengan menggunakan Word.
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Langkah - Langkah pembuatan table:
1. Klik menu Insert pada ribbon
2. Pilih icon table, kemudian Insert Table

Dalam pembuatan sebuah table disediakan beberapa menu tambahan,
antara lain:

1. Insert- Dengan menu Insert kita dapat menambahkan kolom, baris,
dan cell pada saat pembuatan table.Langkah-Langkah: Klik kanan
pada table a Insert a Insert ...... (sesuai yg anda inginkan)

2. Merge - Dengan Merge kita dapat menggabungkan beberapa kolom/
baris menjadi satu.

a. Block baris atau kolom yg anda inginkan terlebih dahulu.
b. Klik kanan a Merge Cells

3. Table properties, digunakan untuk mengatur tampilan table.

a. Block tabel terlebih dahulu
b. Klik kanan a Table Properties

Menutup Word

Bila sudah selesai bekerja dengan sebuah file, pengguna dapat menutup
file tersebut dengan memilih menu Tab File dan click pada tombol Close
atau dapar juga dengan click pada tombol Exit (hanya jika ingin keluar
dari Word).
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Pertanyaan

Nama

Ikon Tombol

Kegunaan

[ A] Membuat gambar lingkaran

[ B] Untuk memberikan warna pada huruf atau

font

[ C] Untuk membuat teks atau kalimat rata di
tengah

[ D] Untuk memberi warna pada garis

[ E] Untuk melihat / menapilkan dokumen sebe-

lum dicetak

B LN e IS

[ F] Untuk membuat teks atai tulisan miring

..}
1]

[ G ] Untuk menyisipkan lembar kerja Excel ke

dalamdokumen Microsoft Word

[Z15)

[ H ] Untuk menampilkan obyek dari clipboard
setelah dicopy atau di cut

0

[ 1] Untuk menyisipkan tulisan indah ke dalam

dokumen

[J] Untuk menyimpan dokumen

- | gl

[ K] Digunakan untuk membuat dokumen baru

[ L] Untuk menyisipkan teks atau gambar dalam
kotak

Ik |

[ M ] Untuk memberikan angka pada kalimat

dlamdokumen aktif

k-

[ N ] Untuk memberikan garis bawah pada kali-

mat atauteks
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[ O] Untuk memberikan shadow pada obyek

gambar
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Microsoft Powerpoint

Pengenalan Microsoft Powerpoint

Micorosoft PowerPoint adalah program aplikasi untuk membuat presentasi
secara elektronik yang handal. Presentasi Power Point dapat terdiri dari
teks, grafik, objek gambar, clipart, movie, suara dan objek yang dibuat
program lain.

Program ini pun dapat dicetak secara langsung menggunakan kertas,
atau dengan menggunakan transparansi untuk kebutuhan presentasi
melalui Overhead, serta dapat dicetak untuk ukuran slide film. Apabila
dibutuhkan dibagikan kepada audiens sebagai bahan pendukung dalam
presentasi, maka kita dapat mencetaknya seperti notes, handout dan
outline.

Mengaktifkan Ms. PowerPoint
Langkah pertama yang harus dilakukan adalah mengaktitkan Ms. Power
Point yang ada di komputer:

Klik START, pilih Program, pilih Microsoft Office, dan kemudian
klik Power Point.
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E Microsoft Access 2010 Productivity

B Microsoft Clip Organizer
S Microsoft Excel 2010
R Microsoft InfoPath Designer 2010
[E Microseft InfoPath Filler 2010
&F Microsoft Office 2010 Language Pre... »
Microsoft Office 2010 Upload Center  Microsoft Edge Microsoft Store
Microsoft Office Picture Manager
F Microsoft OneNote 2010
Microsoft Outlook 2010
LB Wicrosoft PowerPoint 2010
B Wicrosoft Publisher 2010
BB wicrosoft SharePoint Workspace 2010
[@ Microsoft Word 2010
BB Vicrosoft SQL Server 2008
Il Vicrosoft SQL Server 2014

B Microsoft Store

Micrncnft Tn N

Posisi menu bisa saja tidak sama antara satu komputer dengan
komputer lainnya, Jika sudah membuat shortcut dan menempatkannya
pada desktop, maka dapat mengaktitkan Ms. PowerPoint dengan mengklik
(double click) icon shortcut tersebut.

Lembar Kerja Ms. PowerPoint

- X
X}
B\\00O0- & Hhring
AL LDT Ol z S Repiace -
L InAS SN S48 3 setect -
ating
f
Click to add title
Click to add subtitle
Click to add notes 3
Slide 10f 1 | “Office Theme’ IEEEER ol=!
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Tombol File

Di sudut kiri atas adalah tombol Microsoft Office. Ketika Kita
mengklik tombol, menu muncul. Kita dapat menggunakan menu
untuk membuat file baru, membuka file yang sudah ada, menyimpan
file, dan melakukan tugas-tugas lainnya.

Akses Cepat | i«

Sebelah tombol Microsoft Office adalah Akses Cepat toolbar. Akses
Cepat toolbar memberikan Kita akses ke perintah paling sering Kita
gunakan. Secara default, Save, Undo, Redo dan muncul di toolbar
Akses Cepat. Kita menggunakan Simpan untuk menyimpan file Kita,
Undo untuk melakukan rollback tindakan telah diambil, dan Redo
mengajukan permohonan kembali tindakan Kita telah dibatalkan.

Title Bar  presentation! - Microsoft PowesPoint

Judul bar terletak di bagian atas di tengah jendela PowerPoint. Judul
bar menampilkan nama dari presentasi di mana Kita saat ini bekerja.
Secara default, nama presentasi PowerPoint secara berurutan, dimulai
dengan Presentationl. Ketika Kita menyimpan file Kita, Kita dapat
mengubah nama presentasi Kita.

Ribbon

Ket. (1)Tab; (2) Grup Komando; (3) Tombol Perintah; (Launcher)

Kita menggunakan perintah untuk memberitahu PowerPoint apa
yang harus dilakukan. Dalam PowerPoint, Kita menggunakan Ribbon
untuk mengeluarkan perintah. Ribbon terletak di dekat bagian atas
jendela PowerPoint, di bawah toolbar Akses Cepat.

Di bagian atas Ribbon adalah beberapa tab, klik tab menampilkan
beberapa kelompok perintah yang terkait. Dalam setiap kelompok
terkait tombol perintah. Kita klik tombol untuk mengeluarkan
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perintah atau untuk mengakses menu dan kotak dialog. Kita juga
dapat menemukan sebuah peluncur kotak dialog di pojok kanan
bawah kelompok. Ketika Kita mengklik peluncur kotak dialog, kotak
dialog membuat perintah tambahan yang tersedia.

5. Penggaris

Penggaris adalah panduan vertikal dan horisontal. Kita menggu-
nakan mereka untuk menentukan di mana Kita ingin menempatkan
obyek. Jika penggaris tidak muncul di jendela PowerPoint Kita:

Klik tab View.

Klik ruler di Tampilkan / Sembunyikan grup. Para penggaris muncul.

6. Slides, penampung, dan Catatan

Click to add notes

Ket. (1) Slide; (2) Placeholders;(3) Notes

Slide muncul di tengah jendela. Kita menciptakan pada slide
presentasi Kita. Penampung terus objek dalam slide Kita. Kita dapat
menggunakan penampung untuk menahan teks, clip art, grafik,
dan banyak lagi. Kita dapat menggunakan catatan daerah untuk
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menciptakan catatan untuk diri sendiri. Kita dapat merujuk ke
catatan tersebut saat Kita memberikan presentasi Kita.

7. Status Bar, Tabs, Buttons Lihat, dan Lainnya

onl - Microzoft PowerDaint

Click to add notes

Status Bar

Garis Besar Tab

Slides Tab

Lihat Buttons

Zoom

Vertikal & Horizontal Bar Splitter
Minimalkan Button

5@ oo a0 o

Maksimalkan / Tombol Restore
Close Button

-

Status bar yang umumnya muncul di bagian bawah jendela. Status
bar akan menampilkan jumlah slide yang sedang ditampilkan, jumlah
slide, dan nama desain template digunakan atau nama belakang.
Menampilkan tab Outline teks yang terdapat dalam presentasi Kita.
Slides tab menampilkan thumbnail dari semua slide Kita. Kita klik
thumbnail untuk melihat slide dalam Slide pane.
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Memulai presentasi baru
Kita bisa mulai presentasi baru yang kosong dari slide, template, ada

presentasi, atau Power Point outline.

1. membuat presentasi baru yang kosong:
Klik Tombol ‘Microsoft File’

Klik ‘New’ >Klik ‘Blank Presentation’

Presentation’ - Microsoft PowerPoint - 8 x

Available Templates and Themes Blank presentation

@ Home

o 4l [ N 8
S U Aa )
e Sk | et Sl Themes
presenson | tempistes tampites
m Offce.com Templtes -
it = =
= ) i
save & send ) 3 = I
hgendes Awad Clendas G Py Fom
Help ¢ cothemes i : Creste
2 on -
= == = [ — ==
B e i b = | . %) S
= 5 5 = b
Gedtng  Invtstons Imic o lbes P Presntatons Repors Resumesnd Schdoles
Py
a
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2. Untuk membuat presentasi baru dari template:
Klik Tombol ‘Microsoft File > Klik ‘New’ > Klik ‘Installed Templates
atau Browse’ > Klik ‘template’ yang Kita pilih

Penyimpanan Presentasi

Bila Kita menyimpan presentasi, Kita memiliki dua pilihan: Simpan atau
Simpan Sebagai. Untuk menyimpan dokumen: Klik Tombol ‘Microsoft
File’ > Klik ‘Save’
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Kita mungkin harus menggunakan fitur Save As bila Kita perlu
menyimpan presentasi dengan nama yang lain atau menyimpannya untuk
PowerPoint versi sebelumnya. Untuk menggunakan fitur Save As:

Klik Tombol ‘Microsoft File’ > Klik ‘Save As’ > Ketik nama untuk

Presentasi Dalam kotak Simpan.

\E“ = 9 g | Presentationl
Home Insert Design Transitions Animations Slide Show Review View

I save
Recent Presentations

Save As
-

@ M1KBE3 (1)
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Print
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=1 Ch\Users\ASUS\Downloads

Save & Send
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Penambahan Slides
Ada beberapa pilihan bila Kita ingin menambahkan slide baru ke dalam
presentasi: Office Themes, Duplicate Selected Slide, atau Reuse Slides.
1.  Untuk membuat slide baru dari Office Themes:
Pilih slide SEBELUM segera di mana Kita ingin slide baru
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Klik tombol ‘New Slide’ pada tab Home
Klik slide yang sesuai pilihan Kita

BlH9-0
Haome Insert Design Tra

r‘ill % Cut \:l [&=] Layout ~
. 53 Copy E Reset
Paste Mew |..

- ¥ Format Painter | |sgjlige - ‘5 Section 7

Clipboard a Slides

Slides | Outline | X

1]

2. Untuk membuat slide sebagai duplikat dari slide dalam presentasi:
Pilih slide untuk menduplikasi
Klik tombol ‘New Slide’ pada tab Home > Klik ‘Duplicate Selected

. >
Slides
RIEEECE
Home Insert Design Transitions Animations Slide Show

$ Cut #* == Layout ~ - v
ﬁ_'g] Bk J x|
- 53 Copy "|_§| Reset
M

Paste ew s AV Al
- # Format Painter | [sfige = ‘5 Section ~ U e &7 Aa
Clipboard = | | Office Theme
Sides_ | ’
1
Title Slide Section Header
-8 =S i
2
Twao Content Comparison Title Only
—
=
Blank Content with Picture with
Caption Caption
Hj Duplicate Selected Slides
721 Slides from Outline...
‘3 Reuse Slides..,
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Themes/Tema

Tema tersebut adalah desain template yang dapat diterapkan untuk
seluruh presentasi yang memungkinkan untuk konsistensi seluruh
presentasi. Untuk menambahkan tema untuk presentasi:

Klik tab ‘Design’ > Pilih salah satu yang ditampilkan Tema atau klik
tombol Galleries

BIH9-06Is Presentation] - Microsoft PowerPoint

D2 [ O e =

entation -
etup Themes

B colors <
[&] Fonts -
0] effects -

Format Dokumen
Agar presentasi yang kita buat bener-benar sempurna dan layak untuk

ditampilkan, harus melakukan pengeditan dan pemformatan. Dalam

pembuatan presentasi akan bekerja dengan teks, table, slide dan elemen-

elemen presentasi lain.

1.

Bekerja dengan Teks

Teks merupakan elemen presentasi yang paling penting. Agar
presentasi kita menarik dan membantu Anda dalam menjelaskan
sesuatu, maka teks yang singkat, padat, jelas dan menarik sangat
berperan penting.

Menambahkan Teks

Pilih slide di mana Anda ingin memasukkan teks, Klik di Textbox
untuk menambahkan teks

RId9-oi-
" [

Click to add subtitle
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3. Penambahan teks box
Pilih slide yang Anda inginkan untuk menempatkan teks box Pada
tab Insert, klik Text Box Klik pada slide dan tarik kursor untuk
memperluas teks box Ketik teks

IEl‘ H9-0- Presentation - Microsoft PowerPoint |__ Tor |
Home Insert Design Transitions Animations Slide Show Review View Format

L o|m o @ il 1z E
== e Y= B gl 2] B RS
Table Picture Clip Screenshot Photo Shapes SmartArt Chart Hyperlink Action Text Header WordArt Date Slid

- Art A Album ~ A Box | & Footer h &Time Numb
Tables Images Illustrations Links Text

Jicl [ oo I l

4. Pengaturan Teks
a. Font typeface:
Klik panah di sebelah nama font dan pilih font. Ingat bahwa Anda
dapat melihat bagaimana font baru akan terlihat oleh penyorotan
teks, dan hovering melalui font typeface baru.
% S 6= Presentation! - Microsoft PowerPoint
DA P mm [ aale =k

.
| Reset
= Theme Fonts

T Calibri (Headings) =

paste Hew
- < Format Painter | gjige - o Section T

Clipboard £l Slides

Slides | Outline x A Calibri (Body)

All Fonts

F ir A Pompadour Bold Sample
% A Pompadour Sample

Tip Sayat Qursan 2

T AGA Rasheeq V.2 Guby s sl
T fgency B

T ALGERIAN

2 T Arial

% Arial Black

T Arial Marrow

% Arial Rounded MT Bold

T Arial Unicode MS

} Amo Pro

{} Arno Pro Caption

O fmo Pro Display

€} Ameo Pro Light Display

{} Armo Pro Smbd

¢ Amo Pro Smbd Caption =

b. Mengubah ukuran font:
Klik panah di sebelah font size dan pilih ukuran yang sesuai, atau
Klik pada tombol increase or decrease font size.
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c. Font Styles dan Efek
Font style format standar adalah pilihan yang digunakan untuk
menekankan teks. Mereka termasuk: Bold, Italic, dan Underline.
Untuk menambahkan teks ke ini: Pilih teks dan klik font Styles
disertakan pada font grup dari tab Home atau Pilih teks dan klik
kanan untuk menampilkan pengaturan font

d. Ganti Warna Teks
Untuk mengubah warna teks: Pilih teks dan klik tombol Warna
yang ada pada font Group dari Ribbon, atau Sorot teks dan
klik kanan dan memilih pengaturan warna. Pilih warna dengan
mengklik panah bawah di samping tombol warna font.

Video, Audio Dan Animasi

1. Video
Klip video dapat ditambahkan ke dalam presentasi. Untuk
menambahkan klip video: Klik tombol Movie pada tab Insert >Pilih

Movie from File atau Movie from Clip Organizer

Presentation] - Microsoft PowerPoint [ it
Insert Desigy Transitio Animations Slide Show Review View Format

auemwﬁmam@mnjﬂﬂjng Te&ae

Tasle  pictur C\n Sereenshot Pn : Shapes Smartart Chart | Hyperlink Action | Text  Header Wardart Da t s\a Om ect | Equation Symbal || Video | Audio
Box & Footer &Ti - - -
Tables Images llustratiens Links Text symbols Media
: = —

2. Audio
Audio klip dapat ditambahkan ke dalam presentasi. Untuk menambah
klip audio: Klik tombol Audio pada tab Insert > Pilih dari file suara,
Sound from File, Sound from Clip Organizer, Play CD_Audio Track,
atau Record Sound

Presentation] - Microsoft PawerPoint T ]
e [ nset | Design  Transtions Animations  SideShow  Review  View | Fomat

aumuuwﬁmamom- 43-@ T2 &d

Table | Picure Clip Seenshat Photo | Shapes SmanAtt Chart | Hyperink Acion | Text er WordAt Date | Side Objedt | Equation Smel | Video |Audio
- aTime

ssssssssssssssssssssssssssssssssssssssssss
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3. Transisi
Transisi adalah efek yang berada di tempat saat Anda beralih dari
satu slide ke slide berikutnya. Untuk menambahkan slide transisi:

Pilih slide yang ingin Anda transisi > Klik tab animations
Pilih animasi yang sesuai atau klik kotak dialog Transisi

B Presentation! - Microsoft PowerPoint [ |
Home Insert Design Transitions Animations Slide Show Review View Format

X * ¢ w P T x

None Pppest Fade Fiyin Flostin spit wipe

Preview
Preview Animation

Slides | Outline %

£

1

4. Slide Animation
Slide efek animasi standar adalah efek khusus yang dapat ditambahkan
ke objek pada slide. Untuk menerapkan efek animasi:
Pilih objek > Klik tab Animations pada Ribbon > Klik Custom
Animation > Klik Add Effect > Pilih efek yang sesuai

5. Preview Animasi
Untuk melihat animasi pada slide: Klik tombol Preview pada tab
animation

P - =
‘l' Eﬂ lg q ‘j
]
: Home Insert Design

ISk ':. P:"‘_E_Amm: Mo Animation -

|| Preview |Eg[| Custom Animation |

Preview Animations

6. Membuat Link
a. Seleksilah teks, gambar, clip art atau place holder yang akan
Anda Link.
b. Kemudian, Klik Ribbon Tab Insert, lalu pilih Hyperlink
Maka, akan mucul jendela dialog seperti berikut:
1) Existing File or Web Page: Anda me-link pada file yang
telah ada sebelumnya, yang di simpan pada folder tertentu.
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Atau Anda melakukan link ke alamat web tertentu dengan
menuliskan alamat web tersebut pada Address Bar.

2) Current Folder: Link pada file yang ada pada folder dimana
file kita ada.

3) Browsed Page: Memilih link pada drive/folder dimana folder
kita berada

4) Recent File: Muncul file-file yang bisa kita pilih untuk di link

5) Place in This Document: Anda melakukan link pada slide
presentasi yang sama yang sudah Anda buat sebelumnya.

6) Create New Document: Membuat document baru yang akan
kita link dengan slide presentasi yang kita tentukan.

7) E-mail Address: Link pada alamat email tertentu.

Untuk pilihan link berdasarkan slide yang kita pilih, maka kita

melakukan link pada slide lain yang ada pada file presentasi

kita (Place in This Document). Teks yang sudah ter-link akan

berwarna biru dan bergaris bawah.

Melakukan Link pada file lain yang ada di folder (misalkan link

ke format document)

Mencoba aktif tidaknya link yang kita buat.

Untuk melihat aktif tidaknya link yang kita buat, maka kita

harus menjalankan slide presentasi yang telah kita buat tersebut.

Caranya:

1) Mengaktifkan ribbon tab slide show dan memilih salah satu
pilihan pada ribbon start slide show.

2) Mengklik tombol yang ada di bagian bawah, untuk
menampilkan halaman yang sedang aktif.

Untuk setiap halaman yang menjadi link bagi menu utama dari
slide, harus membuat link kembali ke menu utama, atau menu
tertentu sesuai dengan yang di inginkan.
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Menjalankan Presentasi

Saat menjalankan presentasi pada layar komputer (on-screen), seluruh
layar akan digunakan dan komponen-komponen layar seperti toolbar,
menu, dan lain-lain akan hilang dari layar. Cara menjalankan presentasi
ini cukup sederhana, buka presentasi yang akan dijalankan, lalu klik menu
View, Slide Show atau menu Slide Show, View Show

Cetak Handout Presentasi

Pencetakan Langkah-langkahnya adalah Klik tombol File pada pojok
kiri atas tampilan Klik print kemudian pilih print, Isi menu print sesuai
kebutuhan anda
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Microsoft Excel

Pengenalan Microsoft Excel

Microsoft Office Excel adalah aplikasi spreadsheet (lembar kerja) yang
powerful dan mudah digunakan. Hampir semua orang yang bekerja
dengan angka memiliki kemungkinan menggunakan Excel atau aplikasi
spreadsheet lain (seperti Lotus 1-2-3) dalam satu bentuk atau lainnya.

Microsoft Excel adalah salah satu program untuk mengolah data yang
berupa angka dalam bentuk baris dan kolom atau lebih dikenal dengan
sebutan worksheet (lembar kerja). Perangkat lunak aplikasi spreadsheet,
pada umumnya tergabung dalam paket perangkat lunak Microsoft Office.

Excel dapat digunakan untuk membuat dan memformat workbook
untuk menganalisis data dan membuat lebih banyak informasi dalam
pengambilan keputusan. Secara khusus, Excel dapat digunakan untuk
melacak data, membangun model untuk menganalisis data, menulis
rumus untuk melakukan perhitungan pada data tersebut, pivot data dalam
berbagai cara, dan menyajikan data dalam berbagai grafik agar terlihat
profesional.

Perkembangan pengolah data lembar kerja (worksheet), dimulai sejak
diperkenalkannya supercalc, Lotus 123, Open Ofice org Calc, dll. dan yang
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terakhir ini adalah Microsoft Excel yang banyak digunakan di kalangan
masyarakat, pelajar, mahasiswa, dan pegawai dilingkungan perkantoran

Lembar kerja Microsoft Excel terdiri dari 1.048.576 baris, yang
digambarkan dengan nomor 1 hingga 1.048.576, dan 16.384 kolom yang
digambarkan dengan huruf A hingga XFD. Setiap titik pertemuan antara
kolom dengan baris disebut dengan istilah sel (cell), yang masing-masing
dapat diisi dengan data.

Membuka Excel

Microsoft Office Excel dapat dibuka dengan menggunakan beberapa
cara yang berbeda. Jika icon Microsoft Excel terdapat pada Desktop,
dapat dibuka dengan menggunakan dobel klik pada icon tersebut untuk
membuka layar Excel.

Dapat juga membuka Excel dengan cara Klik Start - All Programs -
Microsoft Office - Microsoft Excel
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Lembar Kerja Microsoft Excel
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Lembar kerja excel yang terdiri dari baris dan kolom dapat merupakan
sebagai basis data dimana baris merupakan record yang terdiri dari
beberapa kolom (A s/d IV), sedangkan sel merupakan field. Lembar kerja
excel mudah dioperasikan karena menu-menu (tools) tersedia dengan
lengkap kita tinggal pilih (user friendly)

1. Column, merupakan kolom pada sebuah spreadsheet, dengan

representasi huruf, dimulai dari A sampai dengan IV
2. Row, merupakan baris pada sebuah spreadsheet, dengan representasi

angka, dimulai dari 1 sampai dengan 65536
3. Cell, merupakan bagian terkecil, sebagai tempat penulisan baik teks,

angka, maupun symbol.

4. Name Box, merupakan kotak yang menujukkan letak cell yang sedang
aktif

5. Formula Bar, merupakan kotak yang menggambarkan isi cell aktif,
bisa isi sebenarnya maupun berupa formula (operasi dan fungsi).

6. Sheet, bisa diartikan sama dengan page pada dokumen, namun secara
default MS- Word akan menampilkan 3 (tiga) sheet.
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Memasukkan Data ke Lembar Kerja

Berbagai jenis data dapat dimasukkan ke dalam lembar kerja seperti teks,
nilai, tanggal, jam dan lain sebagainya. Untuk memasukkan data ke dalam
suatu sel, dapat mengikuti langkah berikut ini:

1. Pilih atau klik sel tempat anda akan memasukkan data

2. Ketikkan data yang ingin dimasukkan

3. Tekan Enter atau tombol arah panah atau tombol PgUp dan PgDn

Memperbaiki Kesalahan Pengetikan

Bila ada kesalahan pengetikan data, anda dapat memperbaikinya dengan

mengikuti langkahlangkah berikut ini:

1. Pilih sel yang datanya ingin diperbaiki, lalu tekan F2. Atau klik tombol
kiri maouse 2 kali pada sel yang datanya ingin diperbaiki.

2. Selanjutnya perbaiki data yang salah tersebut dan tekan tombol Enter
bila sudah selesai.

Menggunakan Rumus

Anda dapat memasukkan rumus yang berupa instruksi matematika ke
dalam suatu sel pada lembar kerja. Operator hitung yang dapat digunakan
diantaranya adalah + (penjumlahan), —(pengurangan), * (perkalian), dan
A (perpangkatan).

Penjumlahan
Operasi penjumlahan dilakukan dengan operan satu atau dua cell dan
operator jumlah (+).

Contoh: Isi cell C1 berisi penjumlahan antara cell A1 dan B1, sehingga
pada cell C1 diisi dengan cara = A1 + B1 Isi cell C1 berisi penjumlahan
antara cell A1 dan bilangan 10, sehingga pada cell C1 diisi dengan cara
=Al1+10

Pengurangan
Operasi pengurangan dilakukan dengan operan satu atau dua cell dan
operator kurang (-).
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Contoh: Isi cell C1 berisi pengurangan cell A1 oleh B1, sehingga pada
cell C1 diisi dengan cara a = A1 -B1 Isi cell C1 berisi pengurangan cell Al
oleh bilangan 5, sehingga pada cell C1 diisi dengan cara= A1 -5

Perkalian
Operasi perkalian dilakukan dengan operan satu atau dua cell dan operator
kali (*).

Contoh:

Isi cell C1 berisi perkalian antara cell A1 dan B1, sehingga pada cell C1
diisi dengan cara = A1 * B1 Isi cell C1 berisi perkalian antara cell A1 dan
bilangan 1%, sehingga pada cell C1 diisi dengan cara = A1 * 1%

Pembagian
Operasi pembagian dilakukan dengan operan satu atau dua cell dan
operator bagi (/). Contoh:

Isi cell C1 berisi pembagian cell A1 oleh B1, sehingga pada cell C1 diisi
dengan cara = A1/ B1 Isi cell C1 berisi pembagian cell A1 oleh bilangan
3, sehingga pada cell C1 diisi dengan cara=A1/3

Pangkat

Operasi penjumlahan dilakukan dengan operan satu atau dua cell dan
operator pangkat (/). Contoh: Isi cell C1 berisi pangkat cell Al oleh B1,
sehingga pada cell C1 diisi dengan cara = A1 A Bl Isi cell C1 berisi pangkat
cell A1 oleh bilangan 10, sehingga pada cell C1 diisi dengan cara= A1 A 10

Membuat Range/Blok Sel

Pada saat bekerja menggunakan Excel, kita tidak hanya bekerja dalam
satu sel saja. Terkadang, anda akan bekerja dalam grup/kumpulan sel.
Misalnya saja bila anda ingin merubah jenis huruf beberapa kolom dan
(atau) baris, ingin merubah rumus beberapa kolom dan (atau baris),
copy-paste atau mendelete data beberapa kolom dan(atau) baris, dll
Dalam kondisi2 seperti ini, anda dapat menggunakan range/blok sel ini
untuk memudahkan kerja anda. Range dinamakan menurut alamat sel
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di ujung kiri atas sampai ujung kanan bawah. Sebagai contoh, range dari
sel B2 sampai E7 dituliskan sebagai range B2:E7.

Menghapus Data

Untuk menghapus data di suatu sel atau range tertentu, pindahkan sel ke,
atau buatlah range tempat yang ingin dihapus, lalu tekan tombol Delete.
Dan bila ingin menghapus format tampilan data/sel dapat dilakukan
dengan memilih dan mengklik menu Edit, Clear, Formats.

Memasukkan Rangkaian Data dengan Fasilitas AutoFill

Untuk memasukkan data berupa angka atau teks dengan fasilitas
AutoFill, dapat dilakukan dengan mengikuti langkah2 berikut ini:

1. Pilih/klik sel tempat posisi awal dari rangkaian data yang ingin anda
buat. Misalnya pilih/klik sel B2.

2. Ketik data awal yang anda inginkan. Misalnya teks “Jan” (January)
Pada sel berikutnya (sel dibawah/B3 atau disampingnya/C2) ketik
data berikutnya yang anda inginkan. Misalnya di B3 ketik “Feb”
(February)

Sorot/bloklah B2:B3.

5. Dalam keadaan masih tersorot, arahkan penunjuk/pointer mouse ke
pojok kanan bawah sel B3 hingga tanda plus putih berubah menjadi
plus hitam

6. Tekanlah tombol kiri mouse dan geser/drag posisi pointer mouse ke
sel yang diinginkan misalnya B12. Dengan ini rangkaian data angka
dapat ditampilkan.
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Jenis Data Dalam Worksheet (lembar kerja) Excel
Format Cells, yang menunjukkan jenis data dalam sel ada 12 macam

Format Cells

Mumber i Aignment | Font | Border || Patterns | Protection
Sample
123

Currency

Accounting eneral format cells have no
Date specific nurmber format,
Time
Percentage
Fraction
Scientific
Text
Special
Cuskom

I_ 0] 4 ][ Cancel ]

Pada umumnya format sel (data) yang biasa digunakan ada 3 (tiga)

jenis yaitu:

1. Label, berupa potongan teks/naskah, ciri khas: rata kiri, tengah
(centre), rata kanan

2. Angka (numeric), berupa bilangan/ angka dengan ciri khas rata
kanan, tetapi juga dapat diatur untuk rata kiri, tengan (center), dan
rata kanan

3. Rumus (formula) yang selalu diawali dengan tanda = atau @

Membuat Lembar Kerja Baru
Membuat lembar kerja baru (file baru)
1. Klik menu file

2. Pilih New (Ctrl + N)
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EIE 93

“Hume Insert Fa
H Save

Save As

E Open

L4 Close (]

Info @ﬂ
FH

Mew %Jﬂ

Recent

Print i
X
il
Save & Send
i
&
Help )
&
2] Options

B4 Exit @\__Lﬂ

@

Menyimpan Lembar Kerja (File)

Cara melakukan penyimpanan file pada MS-Excel, langkah-langkah untuk

menyimpan dan memberi nama file:

1. Klik menu File, pilih Save As. Jika mouse tidak berfungsi gunakan
Alt + F + A, atau jika dokumen belum pernah disimpan sebelumnya
gunakan saja Ctrl + S.

2. Tentukan tempat file disimpan, pilih Save in (Alt + i) dan tentukan
di mana file dokumen akan disimpan.
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3. Tentukan tipe file yang akan disimpan, dengan mengisi text field di
sebelah kanan Save as type (Alt + t), untuk MS-Excel menggunakan
type Microsoft Excel Workbook (* xls). Untuk menemukan alternative
tipe penyimpanan klik panah atau gunakan panah ke bawah pada
keyboard.

4. Jikalangkah 1-3 sudah selesai dilakukan, klik Save (Alt + S) atau tekan
Enter pada keyboard.

5. Jika Workbook telah diisi, lakukan penyimpanan secara berkala klik
File > Save (Ctrl + S atau Alt + F + S). Sedangkan untuk menyimpan
dengan nama lain gunakan langkah-langkah seperti saat pemberian
nama.

Menutup Lembar Kerja

Setelah selesai bekerja, untuk mengakhiri (menutup), dapat menggunakan

beberapa cara diantaranya adalah:

1. Menggunakan menu File > Close (Alt + F + C). akan muncul
pertanyaan apakah file akan disimpan sebelum ditutup, klik yes jika
ingin disimpan dan no jika tidak akan disimpan (Gambar diatas)

2. Klik tanda silang ( X') pojok kanan atas bagian bawah. a Klik yes jika
ingin menyimpan dokumen dan klik no jika tidak ingin menyimpan

Membuka lembar kerja (open file)

1. Klik menu file, pilih open atau tekan Ctrl + O, hingga muncul menu
seperti dalam gambar di bawah ini.

2. Cari nama file yang akan dibuka.

Formating, Editing
Editing Data untuk Baris dan Kolom

Cells Pointer yang biasa digunakan untuk editing kolom dan baris seperti
yang tercantum dalam tabel di bawah ini

Frizka Fitriana, S.Kom., M.Kom. _



Tombol Keterangan
4 Pointer untuk memilih sel kiri, kanan, atas, atau bawah satusel
-« ! —>
|
T Cursor akan pindah ke sel baris pertama (1) & misalnya darisel
End + ;
n M, maka akan pindah ke sel M,
Cursor akan pindah ke sel baris terakhir (65536) a misalnya
End +1_ ) e i ( ) Y
dari sel B, maka akan pindah ke sel B,
—

Tombol KETERANGAN

End + Cursor akan pindah ke sel Kolom pertama (A) & misalnya dari sel

M, makaakan pindah ke sel kolom A

350

End + Cursor akan pindah ke sel Kolom terakhir (IV) a misalnya dari sel

kolom B, makaakan pindah ke sel kolom IV

End + | Cursor akan pindah ke sel A1 dari manapun cursor berada (posisi

Home aktif)

Enter Cursor akan pindah satu sel ke bawah

Home Cursor akan pindah ke sel kolom A , dari posisi cursor aktif Kolom
© Baris .

Ctrl + | Cursor akan pindah ke sel kolom A1 dari posisi cursor aktif Kolm

Home X, baris x

PgUp Cursor akan pindah satu layar ke atas

PgDn Cursor akan pindah satu layar ke bawah

Alt + PgUp |Cursor akan pindah satu layar ke kiri

Alt + PgDn | Cursor akan pindah satu layar ke kekanan

Ctrl + PgDn | Cursor akan pindah dari satu tab lembar kerja ke tab lembar kerja

berikutnya
Ctrl + PgDn | Cursor akan pindah dari satu tab lembar kerja ke tab lembar kerja

sebelumnya

Bekerja Dengan Lembar Kerja
1. Sel merupakan tempat dimana data akan di letakkan, lebar dari suatu
sel dapat diatur sesuai dengan panjang data yang akan kita simpan
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2. Istilah dalam lembar kerja:
a. Sel (cell) adalah pertemuan baris dan kolom
b. Range adalah jarak antar sel misalnya sel A1 s/d sel X30 (A1:X30)
3. Memasukkan Data
a. Pindahkan Cursor ke sel dimana data akan di taruh/masukkan
b. Ketik data lalu enter
4. Mengedit Data
a. Pindahkan cursor ke sel tempat data yang akan di edit (diperbaiki)
kemudian tekan F2.

Menghapus Data

1. Menghapus isi sel: pindahkan pointer (cursor) ke sel yang isinya akan
dihapus, kemudian tekan spasi, kemudian tekan enter atau dari posisi
sel yang akan dihapus klik kanan pada mouse pilih clear contents

2. Menghapus baris: pindahkan pointer (cursor) ke baris yang akan
dihapus, tekan mouse kanan, pilih delete, pilih Entire row

3. Menghapus Kolom: pindahkan pointer (cursor) ke kolom yang akan
dihapus, tekan mouse kanan, pilih delete, pilih Entire column.

Mengeblok Data

Cara untuk memperbaiki sebagian besar data dapat dilakukan dengan
mengeblok data yang akan diberbaiki tampilannya misalnya diubah
menjadi Huruf Tebal atau Huruf Miring dsb. Caranya:

Gunakan mouse: letakkan pointer di awal sel yang akan di blok,

tekan tombol kanan mouse (jangan dilepas) geser ke posisi sel terakhir
yang akan diblok

Menyalin Data (Mengkopi)

Menyalin data berati meletakkan data pada tempat yang lain sementara
data asli masih tetap berada di tempat semula. Ada berbagai cara untuk
menyalin data, di antaranya adalah sebagai beriklut:

Frizka Fitriana, S.Kom., M.Kom.



Menyalin data dengan melalui Clipboard

1. Sorot (blok) sel atau range yang datanya akan di copy, contoh sorot
range B2:E12

2. Pilih dan klik menu Edit, Copy atau tekan tombol Ctrl+C. Cara lain
yaitu dengan menempatkan penunjuk mouse tepat pada posisi sel
atau range yang disorot (blok), tekan tombol mouse sebelah kanan
satu kali sampai menu sortcut ditampilkan, lalu pilih dan klik copy

3. Letakkan penunnjuk sel (cursor) ke posisi baru dimana data hasil
copy akan diletakkan, sebagai contoh pindahkan penjuk sel ke G2

4. Pilih dan klik menu Edit, Paste atau tekan tombol Ctrl+V, cara lain
dengan menempatkan penunnjuk mouse tetap pada posisi sel dimana
hasil copy akan diletakkan ( G2 ) kemudian tekan tombol mouse
sebelah kanan satu kali sampai menu sorcut ditampilkan, lalu pilih
dan klik Paste.

Mencetak Lembar Kerja

Untuk mencetak lembar kerja, terlebih dahulu printer yang akan digunakan

telah terpasang dengan baik (terinstall) secara software dan hardware. Jika

dalam komputer terinstall/terpasang lebih dari satu printer, maka untuk

memilih printer ikuti langkah- langkah berikut:

1. Pilih dan klik menu File, Print atau tekan tombol Ctrl+P, kotak dialog
Print terlihat seperti Gambar 5.1

2. Pada tombol daftar pilih Name, pilih dan klik printer yang sesuai
(yang terpasang dalam komputer), kemudian klik Ok

3. Klik Ok.

Membuat Penomoran Otomaitis

MS-Excel bekerja pada tabel, oleh karena itu untuk menandai baris pada
sisi kanan biasanya dibuat penomoran baris. Cara membuat penomoran
secara otomatis dapat dilakukan dengan dua cara. Cara yang pertama,
menggunakan langkah sebagai berikut:

1. Ketikan nilai awal nomor misalnya 1 (satu) pada cell penomoran.

2. Pilih menu Edit > Fill > Series.
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3. Pada radio button Series in pilih Columns dan text area Stop Value
dengan nilai akhir penomoran misalnya 10 (sepuluh).
4. Klik OK

Ketikan nomer awal di cell penomoran

Series E| |‘5_—(|

Series in - Twpe rake
i Rows fs Linear {~
" Columns i Growkh [

- - " Date M

™ Trend ™ AutaFil | £¥e

Step value; Stop walue;
04 | Cancel J

Ketikan nomer berikutnya di bawahnya

2. Blok keduanya dan letakkan cursor dipojok kanan bawah sehingga
cursor berubah seperti bentuk ketiga.

3. Klik kiri, jangan dilepas (drag) dan tarik ke bawah dan berhenti
sampai nomor yang dikehendaki dan lepas klik.

Membuat Link
Untuk membuat suatu link pada excel, ikuti langkah - langkah di bawah
ini:
1. sorot cell yang akan di link apabila itu suatu teks, atau sisipkan shape,
clipart, chart atau yang lain untuk di link.
Pilih Menu Insert, lalu klik hyperlink.
3. Terdapat empat pilihan untuk link, yaitu:
a. Existing File or web page: berfungsi untuk melink-kan ke situs
internet.
b. Place in this Document: untuk melink-kan di worksheet excel
saja Misal di sheet 1, sheet 2atau sheet 3, dll).
c. Create new document: untuk melink-kan pada lembar kerja baru.
E-mail Address: untuk melink-kan pada e-mail.
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4. Klik Ok. Apabila link berupa teks, maka teks tersebut akan berubah
warna menjadi biru danbergaris bawah.

Fungsi Logika

Fungsi logika atau bersyarat memungkinkan kita menguji persyaratan
dalam sel. Fungsi bersyarat ini adalah suatu kondisi atau =IF yang
hasilnya bergantung pada benar atau salahnya pengujian. Fungsi Logika
memerlukan operator perbandingan yaitu:

= (sama dengan)

< (lebih kecil dari)

> (lebih besar dari)

<= (lebih kecil sama dengan)
>= (lebih besar sama dengan)
<> (tidak sama dengan)

Fungsi pada MS-Excel

Fungsi pada MS-Excel digunakan untuk mempermudah pekerjaan pada
tabel. Dari banyak fungsi dapat diklasifikasikan menurut banyaknya
operan (parameter) yang masuk dalam fungsi. Bisa juga diklasifikasikan
berdasarkan disiplin ilmu yang memakainya. Pada pembahasan ini hanya
akan dibahas sedikit fungsi-fungsi berdasarkan pemakaiannya.
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Bab VIII

Canva

Canva merupakan media yang menyediakan template untuk membuat
desai simple. Kita dapat membuat semua grafik, blog, presentasi,
facebook cover, flyer, undangan dan sebagainya.

Cara mengakses Canva
1. Buka alamat www.canva.com

2. Halyang pertama dilakukan adalah mendaftarkan akun kita ke canva.
Pilih salah satu topik yang kita butuhkan. Klik Edukasi yang biasanya
digunakan oleh pengajar dan siswa
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1= - - - - —— S Bi=f—=r
I::-rl||-|l"|-:_|._\':5!.' ikan Canva? Daftar
Dapatkan pengalarnan terbaik dengan

meminen tany kami fungsi yang paling
Anrcia periukan di Camea:

[rbinn (panpajer army paiss

o
=X
o

3. Klik cara masuk yang Anda pilih, bisa dengan akun gmail yang sudah
anda miliki atau dengan email lain.
4. Kemudian verifikasi email yang Anda masukkan, dan canva siap
digunakan
5. Setelah muncul tampilan awal, Anda dapat melihat berbagai design
dengan mengklik More pada kolom create a design.
Adapun Tools yang dapat Anda gunakan di Canva adalah
a. Presentation, untuk membuat desain presentasi
b. Resume, untuk membuat daftar riwayat hidup/Curriculum Vitae
c. Facebook Post, untuk membuat desain gambar yang akan Anda
unggah ke facebook
d. Infographic, untuk membuat infografis
Poster, untuk membuat desain poster
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Cara menggunakan tools Presentation
1. Klik menu Presentation

wu!mnsn "
BIDANG KESHATAN e e

2. Tampilan awal menu Presentation. Adapun tools yang dapat

digunakan adalah sebagai berikut:

Keterangan

a. File, kembali ke Home tempat Anda menyimpan file

b. Undo, kembali ke pengaturan sebelumnya

c. Redo, kembali ke pengaturan sesudahnya

d. Judul, nama file

e. Bagikan, tools untuk membagikan link canva Anda ke berbagai
media

t.  Download, tools untuk menyimpan file

g.  Membuka akses untuk publik, membuka canva Anda agar dapat
dilihat publik

h. Penunjuk Slide Presentasi, menunjukkan susunan slide yang
sedang dikerjakan

i.  Duplikat Slide, menggandakan slide yang sama

j. Slide, slide yang dapat diedit

k. Menambahkan slide baru, untuk menambahkan slide baru sesuai

dengan susunan slide yang sedang dikerjakan
Upload gambar/bagan/grafik, mengupload gambar/bagan/grafik
dari komputer Anda
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m. Gradasi Background, memberikan efek gradasi pada backgroun
slide Anda

Jenis font, menyediakan berbagai jenis font

Shape

Bentuk layout, memilih layout untuk semua slide presentasi Anda

o P o P

Pencarian

3. Klik Layout, kemudian pilih layout mana yang diinginkan. Untuk
layout yang bertuliskan free bisa didownload langsung dalam bentuk
PDE, sedangka n yang tertulis harganya hanya bisa digunakan dan
dipresentasikan secara online

Klik Elements untuk membuat bagan

Klik Text untuk memilik jenis tulisan

Klik Background untuk memilih jenis background

NSV

Klik upload untuk menambahkan gambar

Cara menambahkan Slide baru
1. Klik tanda add a new page, atau

2. Klik tanda Lembar dibawah angka penunjuk Slide, untuk menduplikat
slide

Cara memberikan nama Slide
1. Klik Presentation-Untitled Design
2. Tuliskan nama yang Anda inginkan

Cara mengunduh presentasi

1. Klik Unduh/Download

2. Pilih bentuk file presentasi yang diinginkan

3. Tentukan halaman mana yang akan didownload
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Bab IX

Instalasi Windows

Mengenal Windows 10

Windows 10 adalah sistem operasi komputer pribadi yang dikembangkan
dan dirilis oleh Microsoft sebagai bagian dari keluarga Windows NT dari
sistem operasi. Secara resmi diluncurkan di September 2014 menyusul
demo singkat di Build 2014. Versi pertama dari sistem operasi memasuki
proses pengujian beta publik pada bulan Oktober 2014, menjelang rilis
konsumen pada tanggal 29 Juli 2015.

Rilis pertama dari Windows 10 juga memperkenalkan sistem desktop
virtual, fitur jendela dan desktop yang manajemen disebut Task View,
web Microsoft Ujung Browser, dukungan untuk sidik jari dan pengenalan
wajah login, fitur keamanan baru untuk lingkungan perusahaan, dan
DirectX 12 dan WDDM 2.0 untuk meningkatkan kemampuan grafis
sistem operasi untuk game.

Microsoft digambarkan Windows 10 sebagai “sistem operasi sebagai
layanan” yang akan menerima update terus-menerus untuk fitur dan
fungsionalitas.
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Kelebihan dan Kekurangan Windows 10

1. Sistem windows 10 rupanya memiliki kemampuan menggabungkan
tombol start menu yang terdapat pada windows sebelumnya yaitu
window 7 dan 8.

2. Bahkan keunggulan windows 10 juga terletak pada kemampuannya
menampilkan beberapa aplikasi (multi aplikasi) hanya dalam satu
layar saja.

3. Selain itu dengan kemampuan yang demikian canggih Windows 10
dilengkapi dengan fasilitas virtual dekstop. Pengguna bisa memakai
layar dengan tema yang berbeda dalam satu tampilan layar.

4. Pengguna juga bisa berpindah dari satu dekstop ke dekstop yang lain
dengan cepat. Tentunya ini menjadi sajian yang demikian berkesan
dari sistem baru tersebut.

5. Windows 10 hadir untuk semua kebutuhan perangkat seperti
komputer/PC, gadget, dan lain-lain.

6. Windows 10 jika ingin diupgrade pun tak butuh biaya alias gratis.
Jadi pengguna yang sebelum memiliki sistem operasi Window 7 atau
8 bisa melakukan pembaruan ke Windows 10.

Kelemahan Windows 10:

1. Fitur dan performa yang dihadirkan Windows 10 belumlah optimal.
Lihatlah tampilan pada Windows 10 yang tak berbeda jauh dengn
versi sebelumny yaitu Windows 8.

2. Belum familiar bagi pengguna Windows 8. Bagi pengguna yang belum
akrab dengan Windows 10 barangkali masih akan dijumpai beberapa
kesalahan logika atau bug pada kinerja perangkat.

3. Jika pengguna tak hati-hati saat mengupgrade sistem operasi Windows
10 kemungkinan terjadinya default browser bisa dijumpai. Dan default
browser bakal berubah ke Microsoft Edge secara otomatis.

Cara Instalasi Windows 10:
Ada beberapa cara, salah satunya menggunakan VirtualBox dan USB
Flashdisk atau DVD
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Langkah-Langkah Instalasi Windows 10 Menggunakan VirtualBox

1.

2.

Buka terlebih dahulu VirtualBox yang sudah terinstall. Kemudian
tekan shortcut Ctrl+N untuk membuat komputer virtual.

L]
File Machine Help

{:} e W @ €23 Detais | (@ snapshots
New Settings Start Discard

‘Welcome to VirtualBox!

Oracle VM VirtualBox Manager = =

The left part of this window is a list of all virtual machines on your computer. The list is empty now because you haven't
created any virtual machines yet. % p—

In order to create a new virtual machine, press the Mew button in the main tool bar located £ b \
at the top of the window. 3
You can press the F1 key to get instant help, or visit www.virtualbox.org for the latest

‘?
information and news. g
N B

-

=

Di sini kita diharuskan untuk menamai komputer virtual yang akan
kita buat. Dan menyesuaikan tipe juga versi file ISO yang kita miliki.
Karena kita akan menginstall windows 10, maka pada kolom tipe
pilihlah Microsoft windows. Klik “Next” untuk melanjutkan.

s O €23 petails | (E snapshots
New Settings Discard Start.

() CresteVirtual Machine —

Name and operating system

Please choose a descriptive name for the new virtual machine and select the type
of operating system you intend to install on it. The name you choose will be used
roughout VirtualBex to identify this machine.

Name: windows 10

Type: [Microsoft windows

version: [Qther Windows (54-bit)

[Epercmone] [ mext ] [ cancsl ]

Frizka Fitriana, S.Kom., M.Kom. _



3. Mengatur RAM yang akan digunakan untuk komputer virtual. Klik
“Next” untuk melanjutkan.

RSB v VirtualBox Manager [=[E] = ]

{} s @ = €23 Details | (@ Snapshots
New Settings Discard Start.
L
- (2] = ]
I—— - —— Er. The list is empty now
Create Virtual Machine — - — P
- br "3
Memory size > Fy
Select the amount of memory (RAM) in megabytes to be allocated to the virtual g
machine. 5 2
“\*\ B
The recommended memory size is 512 MB.
...... L ——
P 2045 MB

4. Pada tahap ini klik “Create” untuk membuat harddisk virtual pada
mesin virtual komputer.

mvm VirtualBox Manager [=l=2] = |

W % P = P
Mew Settings Discard Start.
1

T (2] = ]
—— - - - ® - Er. The listis empty now
@ Create Virtual Machine — - —

e
F
Hard disk Y

If you wish you can add a virtual hard disk to the new machine. You can either
create 2 new hard disk file or select one from the list or from anather location using S
the folder icon. X

N .“‘/

o~

If you need a more complex storage set-up you can skip this step and make the
changes to the machine setings ance the machine is areated.

The recommended size of the hard disk is 20.00 GB.
) Do not add a virtual hard disk

@ Create a virtual hard disk now

) Use an existing virtual hard disk file

Empty BR=!

g

5. Selanjutnya pilih tipe berkas untuk harddisk virtual baru, umumnya
yang digunakan adalah VDI. Klik “Next” untuk melanjutkan.
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6.

==

P

(R —
" W% PP

New Settings Discard

(2] = [}
. —

u Create Virtual Hard Disk - - - &

Please choose the type of file that you wouid like to use for the new virtual hard disk. If you
donot need to use it with other virtualization software you can leave this setting
unchanged.

@ VDI (VirtualBox Disk Image)

&) VHD (Virtual Hard Disk)
) VMDK (virtual Machine Disk)

Mext

Expert Mode | | ] [ cancel

Hard disk file type b,

[ snapshots

lhe list is empty now

Pilih “Dinamicly allocated”. Lalu klik “Next”.

== = |

[REBE: vt virtuciion Manager
s ol G
{;:‘; U v

New Settings Discard 2] = |

@CreﬂteV\rtua\HardDisk_ — -

Storage on physical hard disk
Please choose whether the new virtual hard disk file should grow as itis used (dynamically
allocated) or i it should be created at its maximum size (fixed size

A dynamically allocated hard disk file will only use space on your physical hard disk as it
fills up (up to @ maximum fixed size), although it will not shrink again automatically when

space onitis freed.

A fixed size hard disk file may take longer to create on some systems butis often faster to
use

@ Dynamically allocated

) Fixed size

tails | (© sSnapshots

Cancel

Next

|he list is empty now

Aturlah besarnya lokasi dan ukuran berkas yang akan dipakai. Di sini
kita gunakan sesuai yang direkomendasikan yakni 25.00 GB. Pilih

“Create” untuk melanjutkan.
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(6t VM ViruaiBox Manager

{:} et W W

New Settings Discard

3 Details | (@ Snapshots

- ——
@ Create Virtual Hard Disk

|Ei =]

fhe list is empty now

File location and size

folder icon to select = different folder to create the file in,

Windows 10

5}

4,00 MB

Please type the name of the new virtual hard disk file into the box below or dick on the
Select the size of the virtual hard disk in megabytes. This size is the limit on the amount of

file data that a virtual machine will be able to store on the hard disk.

2.00TB

=

20,00 GB

8. Pada tampilan selanjutnya ini, klik menu

“Start” dengan ikon tanda

panah hijau pada bagian atas untuk memulai

[FSIRES vt virtuaibos Manager

B >

MNew Settings Discard  Start

= General

Name: Windows 10
Operating System:  Other Windows (64~
\ bit)

[# system

Base Memory: 512 MB

Eoot Order:  Floppy, Optical, Hard Disk
Acceleration:  VT-x/AMD-V, Nested

Paging, PAE/NX

Display

Video Memory: 16MB
Remote Desktop Server:  Disabled
| Video Capture: Disabled

[ Storage
Cantroller: IDE
IDE Primary Master:
. TDE Secondary Master:
B Audio

Host Driver:  Windows DirectSound
| Controller;  ICH AC37

[ EP metwork

B .EJ, Preview e

Wiindows 10.vdi (Normal, 20,00 GB)
[Optical Drive] Empty

{23 Details Snapshots

9. Pilih ikon berkas berwarna coklat untuk menuju lokasi sistem operasi
kamu diletakkan. Jika sudah, klik “Start” untuk memulai penginstalan.
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W% Oracieputace o ue l—l@ |
[l Windows 10 [Powered OFf] - Oracle VM VirtualBox =

Please select a virtual optical disk file or a physical optical drive
containing a disk to start your new virtual machine from.

The disk should be suitable for starting a computer from and should
contain the operating system you wish to install on the virtual machine
if yau want to do that now. The disk will be ejected from the virtual
drive automatically next time you switch the virtual machine off, but
you can also do this yourself if needed using the Devices menu.

Host Drive 'H:' | &

[ start || cancel

Bodgn= [#] right cirl

10. Pada tahap ini, komputer virtual akan melakukan booting seperti
tampilan di bawah. Tunggu hingga muncul tampilan berikutnya.

11. Ketika muncul tampilan berikut di bawah, ini merupakan jendela
untuk memilih bahasa yang akan digunakan selama penginstallan
berlangsung. Klik “Next” untuk melanjutkan.
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4 Windows Setup (E=N N =

12. Selanjutnya, klik “Install Now”

"4 Windows Setup S| = ]

=@ Windows

Install now

3

13. Tunggu hingga muncul tampilan selanjutnya.

Setup is starting
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14. Pada jendela License terms,

centang pada kolom “ I accept...”
Kemudian klik “Next”

()l vindoussp

License terms

Your use of this software is subject to the terms and conditions of the icense
agreement by which you acquired this software. If you are a volume license

customer, use of this software s subject to your volume license agreement. You
may not use this software if you have not validly acquired alicense for the
software from Microsoft or it licensed distributors,

EULADTIC IR 1EDE V_enus

™ facceptheicense

@ o vindowsseup

Which type of installation do you want?

ade: Install Windows and keep file, settings, and applications

16. Pada tahap ini, adalah pembagian partisi sesuai dengan yang
diinginkan. Klik “Next” jika sudah selesai.
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@ thvincowssewn

Where do you want to install Windows?

Name

Diive Unallocated Space

7

17. Windows setup akan memulai penginstalan windows. Cukup tunggu

sampai proses selesai. Setelahnya windows akan reboot.

4 Windows Setup

Installing Windows

ady fo nstallaton (1%)

18. Tahap selanjutnya adalah Windows akan mulai merestart.
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19. Tunggu beberapa saat.

20. Klik “Use Express Setting” untuk melanjutkan.

Get going fast

Change these at any time. Select Use Express settings to:

Personalize your speech, typing, and inking input by sending contacts and calendar details, along
with other associated input data to Microsoft. Let Microsoft use that info to improve the s

and recognition platformes.

Let Windows and apps request your location, including location history, and use your advertising ID
to personalize your experiences. Send Microsoft and trusted partners some location data to improve
location services.

Help protect you from malicious web content and use page prediction to improve reading, speed up
browsing, and make your overall experience better in Windows browsers. Your browsing data will be
sent to Microsoft.

Automatically connect to suggested open hotspots and shared networks. Not all networks are
secure.

Send error and diaanostic information to Microsoft.

Use Express settings

21. Isilah kolom sesuai dengan perintah untuk membuat akun laptop/
PC anda.

Create an account for this PC

If you want to use a password, choose something that will be easy for you to remember but hard for
others to gut

Who's going to use this PC?
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22. Tunggu beberapa menit dan proses penginstallan Windowss 10 pun

telah selesai.

Langkah-Langkah Instalasi Windows 10 Menggunakan Har-
ddisk atau DVD
Silakan backup dulu semua data file dan dokumen yang ada di Local disk C

1.

Jika harddisk di komputer anda dipartisi silakan rename masing-
masing local disk atau partisi tersebut. Misalnya untuk Local disk
(C:) ganti namanya menjadi Windows (C:), untuk Local disk (D:)
ganti menjadi: Data (D:)

Masukkan Flashdisk Bootable Windows di USB, jika anda ingin
menjadikan USB Flashdisk sebagai sumber installansi. Atau masukkan
DVD Windows ke drive DVD-ROM, jika anda ingin menginstal
Windows dari keping DVD.

Selanjutnya silakan restart komputer anda.

Sebelum mulai loading segera tekan tombol F2 pada keyboard untuk
masuk ke BIOS Setup. Tombol untuk masuk ke BIOS, setiap merk
komputer bisa saja berbeda, jadi silakan sesuaikan dengan merk
komputer anda masing-masing.

Jika tombol yang anda tekan benar maka akan tampil layar BIOS
seperti di bawah ini
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/ Item Specific Help
sHard Drive

*Removable Dewices Keys used to view or
Network boot from AMD AmTICT70R conf igure devices:
<Enter> expands or
collapses devices with
asor-

<Ctrl+Enter> expands
all

<Shift + 1> enables or
disables a device.

<+ and <> the
device up or down.

<> May mowe remowable
device between Hard
Disk or Removable Disk
<> Remowe a device
that is mot installed.

Silakan klik menu Boot di atas kemudian atur agar Removable Devices

menjadi urutan paling atas. untuk merubah urutannya dengan

menggunakan tombol +/- pada keyboard, atau sesuaikan dengan

petunjuk yang ada pada taskbar BIOS pada bagian Change Values

Setelah Removable devices berada di urutan teratas, pilih menu Exit

dan silakan Save.

Komputer atau laptop anda akan kembali restart, tunggu saja sampai

muncul jendela seperti di bawah ini. Pada sesi ini mouse anda sudah

berfungsi.

e Windews Setup | = ]

=m Windows'

Language to install: [English (United States) s

ISR RN R EIRET English (United States) d

Keybeoard or input methed: {1

Enter your language and other preferences and click "Next" to continue
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10.
11.
12.
13.

14.

15.

Pada bagian Time and Curency Format, silakan pilih Indonesia
Pada bagian Keyboard or input method, biarkan apa adanya tidak
usah diganti

Klik Next yang ada di bawah sebelah kanan

Kemudian Klik “Install now” untuk melanjutkan

Muncul halaman lisensi, beri tanda centang pada I acccept the license
terms atau klik skip

Akan muncul jendela pilihan tipe install, Upgrade atau Custom.

g o Windows Setup L

Which type of installation do you want?

Upgrade: Install Windows and keep files, settings, and applications
The files. settings, and spplications are moved to Windows with this option. This opt

Atur Partisi untuk memilih penginstalan sistem sesuai dengan

keinginan.

a. Jika memilih Upgrade, maka Windows lama akan diganti dengan
Windows baru dengan tanpa menghapus semua program aplikasi,
file dokumen, data dan juga virus jika ada.

b. Jika memilih Custom, dengan memformat drive C, maka semua
program aplikasi, file dokumen, data dan semua yang tersimpan
di Local disk (C:) termasuk virus akan musnah. Dan Windows
jadi benar-benar baru belum ada tambahan aplikasi apapun.

c. Jika memilih Custom tanpa melakukan format drive C, maka
folder Document, Ficture, Video, Music dan folder Download
akan tersimpan sementara dalam folder Windows Old. Jadi
nantinya di drive C, akan ada dua folder Windows, yaitu Windows
Old yang tidak aktif dan Windows yang baru diinstall (aktif)
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16.

17.
18.

19.

20.

Drive yang akan kita install yaitu drive C yang telah diberi nama
Windows 10, jadi silakan klik pada Drive 0 Partition 2: Windows 10,
kemudian klik Format

Jika keluar jendela notifikasi Windows setup, klik saja Yes

Tunggu beberapa saat, jika tombol Next yang ada di bawah kanan
sudah aktif berarti proses format drive C telah selesai. Klik saja tombol
Next tersebut

Memulai proses transfer dan instalasi secara otomatis.

Setelah semua intalasi selesai maka komputer anda akan melakukan
restart otomatis. Perhatikan baik-baik, begitu komputer anda restart,
segera cabut flashdisk bootable dari USB komputer anda, dan biarkan
Windows instalasi Windows berjalan sendiri.
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21. Setelah restart otomatis beberapa kali, nanti diminta memasukan data
nama dan pengaturan, bisa diisi bebas.
22. Setelah muncul halaman Windows 10 seperti di bawah ini, berarti

proses instalasi telah selesai

m Bahan Ajar Aplikasi Komputer



BAHAN AJAR

APLIKASI
KOMPUTER "

Buku ini adalah panduan komprehensif yang dirancang khusus untuk
membimbing pembaca dari tingkat pemula hingga menjadi ahli dalam
penggunaan aplikasi komputer. Dengan pendekatan yang sangat praktis
dan berorientasi tugas, buku ini menyajikan informasi yang mudah
dipahami, menjadikannya sumber daya yang sempurna bagi mereka yang
ingin menguasai keterampilan komputer modern.

Pertama-tama, pembaca akan diperkenalkan dengan dasar-dasar
komputasi, termasuk pemahaman tentang perangkat keras dan perangkat
lunak. Setelah itu, buku ini melangkah lebih jauh ke dalam berbagai aplikasi
komputer yang umum digunakan, seperti pengolahan kata, spreadsheet,
presentasi, dan manajemen data. Setiap bab disusun dengan langkah-
langkah praktis, ilustrasi, dan contoh kasus untuk memastikan
pemahaman yang mendalam.

Buku ini tidak hanya membahas aplikasi individual, tetapi juga
mengintegrasikan pembahasan tentang bagaimana aplikasi-aplikasi ini
dapat bekerja bersama-sama untuk meningkatkan produktivitas. Selain
itu, pembaca akan diajak untuk memahami konsep keamanan digital,
rmanajemen file, dan solusi masalah umum yang mungkin dihadapi selama
penggunaan aplikasi komputer.

Dengan menggabungkan teori dan aplikasi praktis, "Menguasai
Aplikasi Komputer” menjadi alat pembelajaran yang efektif bagi mereka
yang ingin mengoptimalkan penggunaan komputer dalam kehidupan
sehari-hari, pekerjaan, atau pendidikan. Buku ini tidak hanya membekali
pembaca dengan keterampilan teknis, tetapi juga memberikan wawasan
tentang bagaimana teknologi komputer dapat meningkatkan efisiensi dan
kreativitas dalam berbagai konteks.
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